
This file, an overview of getting started with D-Star, D-Rats, DMR, and the 
QuadNet Array, was last updated Mar. 24, 2023. A list of the topics that are 
covered in this file, are as follows:

My Station Overview                                           
Obtaining Other Files Related To Ham Radio (Net List, PDF Files)     
Weather, Skywarn, And Station Operations                        
Internet Operations (RF restricted/prohibited (CC&R’s, HOA’s, etc.))  
Getting On D-Star (Registering On The Gateway)                   
Net Etiquette (whether on RF or via Internet Operations)            
Programming Your Rig Or Other Device For D-Star Use             
Accessing D-Star with the BlueDV program                        
Testing Your Signal                                            
D-Rats Overview                                              
Quick Start Guide For Using D-Rats
Using D-Rats with Your D-Star Radio (courtesy of Glen, KG5CEN)                  



Multiple Monitors, and Using Netlogger With Nets                  
File → Preferences (Main Setup)                                 
File → Preferences → Paths                                     
File → Preferences → Maps                                     
File → Preferences → GPS Configuration and APRS Data                        
File → Preferences → Export GPS Messages                       
File → Preferences → Appearance                               
File → Preferences → Chat                                     
Using the OpenWeather App                                    
File → Preferences → Sounds                                   
File → Preferences → Messages                                 
File → Preferences → Radio (Setting Up Ratflectors)               
List Of Selected Ratflectors For D-Rats                           
Nets Where The Selected Ratflectors Are Used                     
File → Preferences → Transfers                                 
Chat Filters                                                  
Chat Rooms                                                 
Pings in Chat, Quick Messages, and QST’s                       
Messages (Email, ICS, Radiogram, etc.)                          
Files (The D-Rats Shared Folder On Your Desktop)                
IObit System Utilities for Windows Systems                      
UTC Times                                                  
Net Memberships and Other Net Links                          
Important Information On Net Times                           
The QuadNet Array      
My Contact Information (including nets that I run during the week) 

My Station Overview:

Several months ago, Microsoft messed up the audio drivers with Windows 11, 
and as a result, the BlueDV program, created by David, PA7LIM (who also 
created the Doozy and Peanut programs), has issues with D-Star under 
Windows 11. On my Lenovo laptop, even with the current version of BlueDV 
(1.0.0.9632 as of Feb. 18, 2023), I can hear other stations fine, but after I key 
up once, I lose everyone else’s audio...so it may be an issue with the sound 
card drivers and the Lenovo laptop. I also have discovered that if one is using 
a utility such as Peerblock, you need to DISABLE it before using things like 
CQ100, its companion QSO-TV program, or the BlueDV program (among 
others), or you can’t connect to most D-Star Reflectors. I ran into that with 



Reflector 58 for the CERT, MDARC, and Alabama D-Star Nets. This does not
appear to be an issue with D-Rats.

With help from Paul, ZL2BEZ, I was able to set up DMR connections to the 
QuadNet Array with the DV Mega Stick 30, and the BlueDV program, but 
it’ll work with the Thumb DV as well. Information on that is toward the end 
of this document. I tried this setup under Windows 11, but I was having 
receive issues on audio as before. As a result, I do all my ham radio stuff 
under Windows 10. If I had known then when I know now, I NEVER would 
have upgraded to Windows 11.

As a side note, the BlueDV program with the ThumbDV or the DV MegaStick
30, are inexpensive ways to get on D-Star, DMR, and Fusion. The ThumbDV 
and the DV MegaStick 30 are much cheaper than the DV Dongle. The last 
time I looked, the DV Dongle was around $200, and it’s used with the DV Tool
program created by Robin Cutshaw, AA4RC. However, the DV Dongle may 
not even be made anymore, and I understand that Robin does NOT respond 
to emails. So, getting support for either the DV Dongle, the DVAP, or the DV 
Tools program, are a waste of time. 

The cheapest D-Star Mobile rig can be at least $500, and the Icom ID-52A D-
Star HT is at least $700, if not more (depending on where you purchase it 
from). Also, Northwest Digital Radio is having big problems keeping the 
ThumbDV in stock...so the better option may be the DVMegaStick 30 from 
Gigaparts...and it’s between $150 and $200. Besides, most hams are frugal 
cheapskates anyway.

Obtaining Other Files Related To Ham Radio:

You can list of several files by going to http://www.wx4qz.net/elk.htm – links 
to other nets on DMR, CQ100, HamSphere, AllStar, Fusion, Christian, and 
other mode related nets, are located further down in this file, just before the 
setup information for the QuadNet Array.

For the Excel Spreadsheets of selected D-Star, Echolink, and D-Rats Nets; 
Microsoft Office, OpenOffice, or LibreOffice...are required to view and work 
with the files. For the other files, a related PDF utility (such as Adobe Acrobat
Reader, or the Fox-It PDF viewer) is required to view them. Some of the PDF 
utilities are read only, while others allow editing of PDF files. As a side note, 

http://www.wx4qz.net/elk.htm


the Fox-It PDF Editor was 50% of the cost of the Adobe Acrobat program. If 
you prefer, the Fox-It PDF Viewer (without the Editor) is free.

The regulators for amateur radio vary by each country. For example, in the 
United States Of America, it’s the Federal Communications Commission 
(FCC). In Canada, it’s the Radio Amateurs Of Canada. In Australia, it’s the 
Wireless Institute of Australia. In the United Kingdom, it’s the Radio Society 
Of Great Britain. So, where the FCC is noted, substitute the amateur radio 
regulation agency for your own country.

If you change your callsigns, you will have to contact the group where you 
registered, and have them update your callsign data. I can’t complain about 
doing such, as I’ve done it. See my bio file at the URL on my QRZ page for 
more info, and pictures of each of my QSL and eQSL cards. As of April 19, 
2022, ham radio operators in the US and its territories, MUST pay a $35 fee 
to the FCC for a NEW or RENEWED amateur radio license, or for a vanity 
callsign request. See https://www.arrl.org/fcc-application-fee for more info – 
the fee must be paid within 10 days, or the application is dismissed. Then, the 
applicant will have to re-file it, and pay another $35 (refunds not available).

Normally, in digital modes, the software will send out your callsign each time 
you transmit. However, to be safe, it’s best that you STILL identify your 
station. In the US and its territories, this is with your callsign once every 10 
minutes, and when you sign off. This can be via the ITU phonetic alphabet via
voice, your callsign via Morse Code, or an image of your QSL or eQSL card, 
via amateur television. You would say “This is [callsign]”, or just “[callsign]”. 
Adding the statement “for ID” or “for identification” is redundant. Doing this
will save you the risk of getting a “Notice Of Violation” for not identifying 
your station. 

Weather: 

Note that nets may be pre-empted for Skywarn ™ severe weather operations 
on various reflectors. Plus, if thunderstorms or severe weather is where Net 
Control is located, another Net Control may need to take over (that has 
happened with yours truly several times). 

Severe weather (tornadoes, large hail, damaging winds, flash flooding, 
lightning (occurs in all thunderstorms, severe or not)), and winter weather 

https://www.arrl.org/fcc-application-fee


(snow, ice, blizzards, etc.), all occur worldwide. While Antarctica hasn’t seen 
tornadoes, every other continent has...and every continent has seen winter 
weather somewhere, at some time. 

For stations in the U.S. or its territories, go to www.weather.gov , then enter 
your zip code in the box, select the desired link, then click GO. You’ll get a 7 
day point forecast from the National Weather Service for your area, along 
with links to any current watches, warnings, or advisories in effect. For the 
stations outside the U.S. and its territories, please check with your local area 
meteorological service. 

Note that all the surge protection in the world will NOT protect you from a 
direct or close lightning strike. Each lightning bolt:

! Has 3 million volts, and 300,000 amps of electricity.

! Can strike from 20 to nearly 500 miles from the parent thunderstorm. The 
three longest strikes recorded were 477 miles from coastal Texas to southern 
Mississippi in 2020...441 miles across southern Brazil in 2018...and just prior 
to that with a 200 mile strike across Oklahoma. 

! Can be as wide as your thumb, but 5 miles long at minimum.

! Is 50,000 degrees Fahrenheit (5 times hotter than the sun’s surface).

! Gives little if any indication where it will strike next. By the time you feel the
static charge, you are in imminent danger of being struck...and either being 
seriously injured, or killed. Go to https://www.weather.gov/safety/lightning 
for lightning safety rules. 

In short, it’s no contest. ALL thunderstorms, whether they are severe or not, 
will produce lightning. Some thunderstorms produce very little lightning, but 
others are prolific lightning producers. And, it only takes one strike to do 
damage.

For the record, according to the National Weather Service, a thunderstorm is 
classed as “severe” if it produces the following:

https://www.weather.gov/safety/lightning
http://www.weather.gov/


! Tornado or Funnel Cloud. Both are violently rotating columns of air. The 
tornado is a funnel cloud in contact with the ground, while the funnel cloud is 
not in contact with the ground. The terms are NOT interchangeable. For 
tornado safety tips, go to https://www.weather.gov/safety/tornado.

! Hail 1 inch in diameter or larger (the size of a quarter (25 cent piece)), 
AND/OR Winds, Sustained or in Gusts, of 50 knots (58 mph) or more. For 
thunderstorm safety tips, go to https://www.weather.gov/safety/thunderstorm.
All of these are threats to the safety of life, and protection of property.

Note that each thunderstorm contains at least 500,000 tons of water. So, if 
that falls in the same area quickly...or if multiple thunderstorms repeatedly 
move over the same area...urban and flash flooding is likely to result. Do NOT
drive through, or walk across flooded areas!! It only takes 6 inches of moving 
water to sweep you off your feet...and only a foot of moving water to sweep 
vehicles off the road. Some roadways have signs that note “ROAD UNSAFE 
WHEN UNDER WATER”. If you choose to ignore the warnings, and drive 
into the floodwaters, you may end up drowning. For flash flood safety rules, 
go https://www.weather.gov/safety/flood. 

You’re also endangering the lives of the first responders trying to save you, 
because of your STUPIDITY; since you chose to drive into the floodwaters in 
the first place!! In some areas, once survivors are rescued, they likely will be 
BILLED for the very high cost of emergency services personnel rescuing 
them!! Basically, the “safety rules” in the weather warning and weather 
advisory bulletins are NOT there “just to take up space”!! And, if you ignore 
them, you do so at your own peril...literally at the risk of losing your life!!

Internet Operations (no RF): 

If you’re operating “internet only” for the nets noted (you can’t have RF gear 
at your QTH, due to antenna prohibitions, HOA’s, CC&R’s, medical (heart) 
or other issues):

First, dial-up internet is STRONGLY DISCOURAGED, as it’s WAY TOO 
SLOW!! Your only options are either DSL (much slower than broadband), 
broadband, a mobile hotspot (smartphone or rig), or a portable Wi-Fi device.

https://www.weather.gov/safety/flood
https://www.weather.gov/safety/thunderstorm
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Note that portable Wi-Fi connections can be erratic at times, especially 
during bad weather; but one should be offline, unplugged, and off the air, 
during thunderstorms, anyway, as noted above.

If you’re using a portable device, if you checkin to several nets, try to get the 
“Unlimited Data Plan”. The advantage with a Verizon Mi-Fi and a laptop 
computer, is that you can do a “demo” of “internet radio”, such as at a high 
school ham radio club. And, with a private Wi-Fi with a password, you don’t 
have to worry about folks piggybacking on your connection; not to mention 
that you can get an internet connection in most areas. To the best of my 
knowledge, Verizon is the only company that has such a portable device.

NOTE: If you use a program such as Peerblock, it MUST be DISABLED 
before using CQ100, QSO-TV, BlueDV, or related programs...or they won’t 
work. You are free to re-enable these once you are done with using the noted 
programs. While some of the reflectors will work with the BlueDV program, 
even if Peerblock is running, you’ll find that most others will not allow you to 
connect, until you disable it.

While the “ham radio purists” (those who feel that ANY form of “internet 
radio is NOT ham radio”) cringe at this concept...the bottom line is if one 
can’t get on the air, WHY get or stay licensed?? One’s health can change in 
the blink of an eye (never mind the fact that tomorrow, let alone the next 15 
seconds, is promised to no one), and I personally can NOT see why we should 
penalize a long time ham, who because of health or other issues...one day, they
realize that they can no longer operate RF; and basically be forced to give up 
the hobby. 

Besides, there’s something in the hobby for everybody. Loneliness, especially 
in places like nursing homes, can cause the person to “lose the will to live”. 
And, the outbreak of Covid-19 and the constant new variants has made things
that much worse; because their families are kept from seeing them.

Plus, operating “internet radio” is far cheaper than buying all the rigs, power 
supplies, accessories, SWR meters, coaxial cable, antennas, towers, etc. – and 
most hams are “frugal cheapskates”, anyway. Several years ago, there was a 
“DC To Daylight” rig at Hamvention in Ohio for $20,000...and in some areas, 
that’s the cost of one semester or one year in college!! Now, I could outfit a 



nice shack for that, or buy a nice pre-owned vehicle. But, for just one rig...to 
me, that’s overkill, plain and simple.

There are two other reasons for operating internet radio. First, it’s COST – 
although “you get what you pay for” in rigs, from a simple $50 HT to a DC to 
Daylight rig worth several thousand dollars...plus all the needed accessories 
(power supply, microphone, keyer, speakers, SWR Meters, coaxial cable, 
antennas, feed line, towers, etc.). With having a computer, all you need is a 
high speed internet connection (DSL/broadband; dial-up NOT recommended,
as it’s too SLOW)...a headset microphone (preferred, to cut out background 
ambient noise)...the needed mode software...and the appropriate amateur 
radio license. For students in high school amateur radio clubs, they are more 
concerned about the money for college tuition, than for a rig with all the bells 
and whistles they could want. 

Unfortunately, I had to stop driving and sell my car in mid-2022. The vision 
issue was “dry corneas”, which would cause blurred vision and pain, which 
would occur without any warning...and obviously, you can’t have that when 
you’re driving. While I use Systane Eye Drops several times a day, I can’t do 
much of anything for at least 5 to 10 minutes, until the stinging and burning 
from the drops has stopped, and my vision has cleared. My eye doctor said 
while I have “suspect glaucoma”, I’m in no danger of going blind at this time 
(but my getting in and out of hamfest parking lots is another story (hi hi)).

While those on “internet radio” only, do likely realize that if power or their 
internet is out, they are effectively QRT (off the air), at least they can still get 
on the air much of the rest of the time. A file with more info on “Operating 
Internet Radio”...covering the modes of Echolink, D-Star, D-Rats, Packet Via 
Telnet, and Winlink...is located at the hyperlink URL noted on my QRZ 
bio...a PDF viewer is required.

First, to get on to D-Star, you have to be registered with the Gateway. 
Otherwise, your transmission will ONLY be heard on local area repeaters. 
However, if they’re not D-Star capable, and if they’re not on the Gateway, it’s 
not going to matter whether you’re registered or not. But, as noted earlier, 
with digital modes, when you key your rig or the computer program, your 
callsign is transmitted. In other words, “you can’t hide on D-Star”. But, if you
don’t register, the reflector won’t accept your transmissions.



Getting On D-Star (whether RF or via “internet radio”):

As noted, to register, go to https://regist.dstargateway.org/Dstar.do – you’ll see
something similar to this screenshot that is noted above, with these available 
options:

1) Already Registered – Enter your callsign and password to logon. A link is 
further down in the page if you have forgotten your password. Enter your 
callsign (must be in upper case), and the email address you used to register on

https://regist.dstargateway.org/Dstar.do


the gateway. An email will be sent to you, with a link to enter and confirm a 
new password.

2) New User – For details, go to https://regist.dstargateway.org/instructions/ –
be sure to follow all the steps noted. Once the process has been completed, you
will be able to use D-Star. Note that if you change your callsign, you will have 
to re-register. 

Again, for ham radio operators in the US and its territories, as of April 19, 
2022, a change in callsign, sequential or vanity, will cost you a $35 fee, 
payable to the FCC. Details are at https://www.arrl.org/fcc-application-fee 

3) Forgot Password – see item 1 above.

4) Verify My Registration – enter your callsign and click Submit.

Note: If you have trouble getting registered, contact Terry, N8LN (his email is
good on QRZ). He’s one of the administrators for the US Trust Servers (the 
REF reflectors), and should be able to assist you.

Details on getting registered with DMR are later in this document.

Net Etiquette (RF or Internet):

Before we get to programming the rigs, etc., these items are NOT covered in 
the Question Pools for ham radio license exams...yet, I feel they need to be.

A. You’re REQUIRED to follow the instructions of Net Control, whether they 
are male or female. Their job is to run the net...whatever the subject or theme,
whether sponsored by a certain club or not...and whether the subject is ham 
radio or not...in the way they see fit, persuant to FCC Rules (or the country’s 
amateur radio regulator), and to keep control. 

There are other things and hobbies in life besides amateur radio (although 
some may be offended by that (hi hi))…but amateur radio IS a HOBBY. In 
other words, do NOT let ham radio take priority over things like church, 
health, family, job, or especially “honey-do’s”. If you do, that new rig you 
have your eye on for your birthday, or for Christmas, may be going back to 
“the candy store” (hi hi).

https://www.arrl.org/fcc-application-fee
https://regist.dstargateway.org/instructions/


Please listen to Net Control for instructions, as most all nets are DIRECTED; 
which means that all calls will go through Net Control. Note that some nets, 
while still directed, may be a bit more “laid back/casual and comfortable”. 
However, each net is run differently...and all Net Control is required to do is 
to run the net the way he or she sees fit, persuant to the amateur radio rules 
of their country, and to keep control...whether the net is affiliated with a 
certain club, organization, etc. or not.

If you try to defy that, you risk being reported to the Virtual Monitors, who 
may turn the info over to the FCC for Enforcement Action against you, and 
you could have your ham radio license suspended or revoked...not to mention 
having your gear confiscated, and you being arrested, levied a hefty monetary
fine, and jailed. You may also be reported to the repeater or reflector trustee; 
who will either remove your callsign from connecting...or set your station to 
“listen only”. In either case, you will NOT be able to transmit. In some cases, 
law enforcement may also show up at your door, to arrest you.

As noted in the Net List Spreadsheet file at http://www.wx4qz.net/elk.htm -- 
there are over 200 D-Star, Echolink, and D-Rats Nets, that meet weekly, or as 
little as once a month. Links to the DMR, CQ100, D-Star HF, Hamsphere, 
AllStar, FreeStar, WIRES-X, System Fusion, and Christian Nets are noted 
later in this file. So, if you don’t like the way a certain net is run, just remove 
that net from your list, and go to another net that may be more to your liking.

B. Note that with all of the digital modes, your callsign shows up when you 
transmit...so you can NOT hide, as it were. However, as noted earlier in this 
file, you will need to identify your station, if ANY of your transmission is done
by voice, and identify at the intervals required by your country. In the US and
its territories, this is once every 10 minutes, and at the end of your signal 
transmission (when you sign off). It can be done via voice with the callsign 
(“this is [callsign]” or “[callsign]”), your callsign via Morse Code (no more 
than 20 words per minute, or an image of your QSL or eQSL card.

If you’re not at the Control Point, be sure that you have means implemented 
to prevent unauthorized operation of your station. Otherwise, enforcement 
letters from the Virtual Monitors, or the FCC, may come to you; and you’ll be
liable for fines, etc., and could possibly have your license suspended/revoked. 
Then, the actual station committing the violations, could get off “scot-free”.

http://www.wx4qz.net/elk.htm


C. Please allow 5-10 seconds at the start of any net to allow all of the linking 
repeaters to synchronize, and stations not wishing to participate in the net, to 
unlink their local repeaters from the Reflector. Just prior to the start of the 
net, the Net Control Station may check to see if there’s any Emergency Traffic
(life and death urgency, right now, to those involved). If so, the net will be 
suspended, until this is taken care of. If you’re on the frequency or reflector 
where the net is to be held, please clear the net frequency if and when asked 
to do so. No one has the exclusive use of ANY frequency, reflector, etc. in 
amateur radio.

In using the 4 types of Formal Written Traffic that’s handled on National 
Traffic System (NTS) Nets on ham radio...it is NOT an EMERGENCY, if 
your ROUTINE traffic is not given PRIORITY, as your HEALTH AND 
WELFARE (your ego) will be shattered otherwise. In short, “Life is NOT Fair
or Burger King. Fair is a fall carnival, a weather term, or a call in baseball; 
and you can NOT always ‘Have It Your Way’ (I worked for them over 40 
years ago).

If the net does conduct early checkins, do NOT show up at the last minute 
with routine traffic, and expect to be put to the front of the line, especially if 
your traffic is ROUTINE. If you try bucking in a ticket line at a concert or 
sporting event, to get to the front...you may be beaten to death, because of 
your impatience!! I see NO REASON to make an exception for these selfish 
and impatient ham radio operators, who act like they’ll die, if they’re not 
given first priority, if it’s not an emergency situation. Basically, I don’t want 
or need them on my nets...plus, I’ll call them down on the air, and turn them 
into the repeater trustee, the Virtual Monitors, and the FCC.

I refer to these stations as “Hi, Bye, And QSY” checkins...where it’s always 
“Net Control, Please Checkin [Callsign], [Name], [Location], Short Time, No 
Traffic”. Not a minute later, they are another net, doing the exact same thing!!
There is more to life than checking into a ham radio traffic net.

Now, if it is a bona fide Emergency situation (involving the safety of life and 
or the protection of property), those stations can break into the net at any 
time. At that point, Net Control will stop the net, and those on the frequency 
will try to help the party with Emergency Traffic deal with the situation. The 
net won’t resume regular operations, until the emergency traffic situation is 
resolved, and the frequency is returned to regular use. As far as the FCC is 



concerned, with a bona fide Emergency situation, “you can throw the rule 
book out”.

D. Stations should enable the Busy Channel Lockout, BCLO, feature of their 
transceiver. Doing so will prevent doubling with other stations. If using 
Echolink, please set the “textbox alert for doubling” to ON.

E. Please avoid “tailgating” whenever using the D-Star network...basically, a 
“Digital Demolition Derby”. You should pause for several seconds after your 
transmissions to allow the systems to recover (I myself am doing “an 8 to 10 
count” to let everything reset). Otherwise, stations won't be seen or heard, 
especially if they “quick key” to do a net checkin. This is true on the QuadNet 
Array, or the Sunflower Net...where you have several modes connected at the 
same time. What ends up happening is that the “tailgating station”, and 
others trying to connect, or on that link, will all get “kicked off”; and Net 
Control won’t get any of them. Those on C4FM won’t hear anything, if 
several stations key up too quick.

F. If using a “hotspot” with your rig, and your signal “drops” a half second 
after you key the mic, chances are your hotspot is being “de-sensed” by the 
RF from your radio, due to it transmitting on HIGH power. Change the 
power setting to LOW, and everything should work. Several other hams have 
encountered this issue.

G. While some D-Star Nets allow “quick key checkins”, other nets require 
voice checkin. If Net Control is visually impaired, it helps them if you checkin 
via voice, slowly and using the ITU Phonetics for your callsign...and you may 
need to do such twice, to be sure that they got it correct.

For “quick key checkins only”, it means EXACTLY that; voice checkins will 
NOT be accepted. You key your PTT (push to talk) one time, for at least one 
second, when the frequency’s clear. The Net Control Station will see you on 
their “dashboard”, such as DPlusReport, Pi-Star, etc. There’s no need to say 
anything, until you are called on by Net Control. The ONLY exception is if 
you have to break in with Emergency Traffic.

H. While some nets will do “early bird” or pre-net checkins, others will not. 
These, and the time allowed for such, are at Net Control’s discretion. These 
can be from 15-30 minutes before the net. They may also offer an extended 



checkin window via the Facebook group. For some Net Controls like myself, 
it’s very difficult to sit in the computer chair for extended periods of time.

I. In some cases, “short time” (or “in and out”), means that you can’t stay for 
the net, you just want to be logged as “a bean for the count” only. The same 
applies if you want to be “listen only” (with no comments). Once you’ve been 
acknowledged, you may secure your station at your leisure; but you are free 
to listen as long as you like. You can recheck later in the net, if you need 
to...but you’re not obligated to do so.

To me, if your status is “short time”, it means that you have another task at 
hand...such as checking into another net that meets at the same time, a task at
home or work that you have to complete, a personal or family medical issue, 
you’re mobile (especially if you’re in traffic, and need to concentrate on your 
driving), it’s meal time with the family, or something else. If you want to pass 
traffic, you’re expected to stay for the net, and participate in it. Otherwise, 
you may end up “out of the loop” on info related to the hobby.

J. When keying up, please leave a 5 to 8 second gap between when one station 
unkeys, and before you key up. Then, wait 2 seconds after keying up before 
speaking, to allow the repeaters to send data, and then synchronize with the 
reflectors and other repeaters in the network. Otherwise, the first part of the 
transmission will be cut off. This is also true with any connections over the 
internet, due to latency...which results in a slight delay in audio. Again, those 
systems with C4FM will NOT hear other stations, if stations key up too quick.

K. If you’re using a ThumbDV, a DV Mega Stick 30, a DV Dongle, a DVAP, or
a Hotspot, you can access the net by connecting directly to one of the 
reflectors that are being used for the particular net. Do NOT connect to a 
local repeater, that’s already linked into the reflector…and if you’re using 
multiple Hotspots, be sure that only ONE is on the reflector for the net…and 
not also to a linked repeater...or a digital loop will likely result.

There’s a widespread problem with those using certain hotspots, as several 
ham radio operators are leaving more than one of these connected to a certain
reflector simultaneously (for example, more than one hotspot is on certain 
reflectors), just in “listen mode”; especially on reflectors 1 and 30. What ends 
up happening, is that one station hotspot from a certain IP address connects, 
then a second station hotspot from the same IP address repeatedly tries to 



connect. As a result, the callsign is banned from the reflector, because the 
constant retries end up crashing the system. Right now, they’re blocking these
by IP addresses, but may eventually block them via callsigns; which makes it 
impossible to reconnect to the system or network.

With the USB connection for each of these, they can be plugged into either the
computer USB port DIRECTLY, or a USB hub. Sometimes, if you don’t key 
up for some time...or if you have several other programs running, the device 
may “go to sleep”, irrespective of your computer power settings. To disable 
the “USB selective sleep” on your system, go to this link for more 
information:

https://www.windowscentral.com/how-prevent-windows-10-turning-usb-
devices 

The instructions at this link may also work with previous versions of 
Windows, as each have a similar Control Panel. These include Windows XP, 
7, and 8. With the release of Windows 11 on Oct. 5, 2021, anything prior to 
Windows 10 is no longer supported by Microsoft, in regards to updates, for 
security issues or otherwise. If you want support, security updates, etc., you 
will have to pay a large amount of money to Microsoft. Apparently, Windows 
10 will be supported through sometime in October, 2025. Many folks have 
various applications that will NOT work under Windows 11, so your only 
choices may be to stay with Windows 10 and potential security risks...or 
switch to Linux or even Mac...but either way with a new operating system, 
there will be quite a bit of a learning curve.

You want the Power setting, Change Power Plan Settings, Advanced Power 
Plan Settings, and the USB Selective Sleep Mode – change them to 
DISABLED.

L. If you’re using D-Rats, D-Chat, DPRS, automatic beacons, or items that 
would cause your rig to key up without your intervention, please set your rig 
to transmit ONLY when you key the PTT (push to talk), or disable it entirely. 
Otherwise, it could drop your link into a black hole, taking you and everyone 
else with it...and all of the other disconnected stations will NOT be happy.
M. Once the net has been secured by Net Control, please stand by for at least 
2 minutes, to allow connected systems to unlink from the reflector (I believe 

https://www.windowscentral.com/how-prevent-windows-10-turning-usb-devices
https://www.windowscentral.com/how-prevent-windows-10-turning-usb-devices


that DMR users term this as “a 4000 disconnect”. Once that is done, if you 
want to chat with another station on the repeater or reflector, you can do so.

Programming Your Rig Or Other Device For D-Star Use:

You must be registered on the gateway, as noted earlier in this document, 
before proceeding. Once registered on the gateway...if you don’t do this setup,
you’ll only be heard on the local repeater. 

To do such, in RPT 2 (or in the FROM section if your radio has a DR mode 
with it), you need to have your local repeaters callsign, then the needed blank 
spaces, depending on the callsign length (callsigns are either 4, 5, or 6 
characters, with the region number). But, space 7 needs to be blank, and 
space 8 needs to have a G in it (for Gateway). 

In the UR Field, you will need to have CQCQCQ (or either CQCQCQ Use 
Repeater or CQCQCQ Use Reflector in the TO section, if your radio has a 
DR mode). The RPT 1 or MYCALL field will usually show your callsign. As 
noted above, those using a DV Dongle, a DVAP, a ThumbDV, or a Hotspot, 
can access the net by connecting directly to the repeater…or preferably, the 
reflector used by the net, instead of going in through the local area repeater.

As for linking and unlinking, that can be rather confusing. However, I’ve 
found a D-Star Quick Start Guide from Rob Locher, W7GH, at:

http://www.roblocher.com/whitepapers/dstar.html 

If you’re using the blue DVDongle with the DVTool program by Robin 
Cutshaw, AA4RC, you’ll recognize several of the terms in that link.

Accessing D-Star With The BlueDV Program:

For more details on the BlueDV program, go to http://www.pa7lim.nl/bluedv/ 
– click on your operating system (Android, Linux, iOS (Mac), Windows, or 
AMBE3000. There will be links to follow to download the latest version. In 
checking the site, I know that there are versions for Windows and Linux; but, 
I’m not sure about a version for iOS or Android offhand.

http://www.pa7lim.nl/bluedv/
http://www.roblocher.com/whitepapers/dstar.html


David, PA7LIM, has done a great job with ham radio programs (including 
BlueDV, Peanut, Doozy, and others). If you can make a donation to him, I’m 
sure he’d greatly appreciate it. With the BlueDV program, you can work D-
Star, DMR, and Fusion, with either a ThumbDV from Northwest Digital 
Radio in Washington state, or via a DV MegaStick30 from Gigaparts. 

As noted earlier, Northwest Digital Radio is having a big problem keeping the
ThumbDV in Stock...so using the DV MegaStick30 may be the better option.
More details on these are after the screenshots on subsequent pages. 

If you have to do a rebuild of Windows and the registry, and have to reinstall 
things, that’s where this file comes in handy on the setup information. I’ll 
note that when I upgraded my laptop from Windows 10 64-bit to Windows 11 
64-bit, I did NOT have to reinstall any of the Windows related programs; 
including the BlueDV program, D-Rats, Echolink, Outpost Packet Manager, 
or Winlink Express. If you’ve ever had to rebuild the registry in Windows, 
you know what a pain that is, as it can take several hours to finish everything.

Here’s how to setup BlueDV, once it has been installed.



The latest version, 1.0.0.9632, as of Feb. 18, 2023 (I’m using Windows), has a 
new mode now, NXDN, to go with the previous modes of DMR, D-Star, and 
Fusion. IT also has expanded the basic station info, with CALL, NAME, 
CITY, COUNTRY, and INFO. For information on NXDN, click on the HELP 
link noted after the NXDN ID window. You’ll need to go to radioid.net to 
register. Next, click on Menu → Setup. Then, start with the screenshots noted,
starting below. While screenshots from 1.0.0.9631, the features are the same.

The boxes are as follows (again, this is for BlueDV for Windows). When a new
version of BlueDV is released, and you want to upgrade, UNINSTALL the 
current version FIRST; then you do a fresh install of the new version. Your 
previous system settings are NOT lost in the uninstall process. 

If the new version won’t install, chances are that your Windows registry is 
corrupted, and you’ll have to reinstall Windows. In this case, it’s best to do it 
from the cloud, and “keep the non-Windows files”...otherwise, it’s like you’re 
formatting your hard drive, and you lose everything). It then will reinstall 
Windows, and rebuild the registry, as well as creating a page of all of the 
Windows programs you’ll have to reinstall. You should then be able to install 
BlueDV (this happened to me). Note that the reinstallation process will take 



quite some time to complete...so you won’t be able to do any computer work 
until this is finished.

There are no receive audio issues with Windows 10 systems...so, it may best to
run things under Windows 10. I have blanked out my data...you will need to 
enter the data applicable to your station and setup.

! General: 

@ Your call – Enter your callsign – do NOT enter an SSID with it.

@ Serial Port Radio – Enter the comport for your computer soundcard, the 
ThumbDV, or your rig. This could be a serial port or a USB port, as is the 
case with the ThumbDV. There are devices available for purchase on the 
internet to convert a USB port interface to a serial port interface (in case you 
have an older computer)...but most computers today have USB ports only.

@ Save QSO Log – check the box if you want to save the QSO Log.

@ RX/TX Colors and Invert RX/TX screen – check the boxes for this, if 
desired. Normally, in transmit mode, it’s red...in receive mode, it’s green...and
if waiting on a signal, it’s blue. Choosing “Invert” will reverse the colors.

@ Frequency – I have mine set at 4343000000.

@ Mode Timer – I have mine set at 10 seconds.

@ Radio TX Power – Adjust the bar to the desired setting.

@ Latitude and Longitude: Enter the desired values, and check if you want 
this on top. There are several GPS utilities, websites, and smartphone apps 
that’ll provide this data.

@ Language: Choose the desired language. It’s effective when you restart the 
program.

For the modes below (D-Star, DMR, and Fusion), if you do NOT have the box 
“Enable At Start” checked (as noted below), you then can decide on which 
mode you want to use with the program when you start it.



! D-Star:

@ DSTAR Module: Choose the desired module (A, B, C, D, etc.).

@ APRS: Check this box if you want data sent on APRS. As a side note, if you
receive an APRS chat from someone, the display will have two red rectangle 
boxes on the lower left, as in the screenshot below.

To get to it, click on the APRS chat window in the upper right. The APRS 
option is optional (the screenshot is from a previous version, but it should still
work/apply).

@ Enable at Start: Check this box if you want this enabled at the start.

@ Default Reflector: You MUST enter something here, such as REF048B; 
which is the main reflector for the Arklatex D-Star Net, which I run every 
Tuesday at 7:30pm US Central Time. Leaving that space empty will cause an 
error, or the program will crash.

Once set up, choose DSTAR for the mode. Then, select the desired mode from 
REF (US Trust Server Reflectors), XRF (X-Reflectors), XLX, or DCS 
reflectors. Then, choose the desired reflector and module. 

To transmit, click on the bar in the lower right. It’s recommended to have the 
PTT Lock box checked...this way, just click on the bar once to transmit (key 



the PTT), and click on it again to unkey. If you wish to mute the speaker, click
the appropriate box.

**
! DMR:

Enter your DMR ID Hotspot Number. If you don’t have a DMR ID, you must 
logon to the Brandmeister Network, and register with the network.

The number entered here will be your DMR ID number, then you enter 2 
digits for the number of your hotspot. If you only have one Hotspot (even if 
it’s with a ThumbDV or DV MegaStick 30 only), you enter 01 after the DMR 
ID that you received upon registration. The next box is your DMR Simple 
ID...which is basically your DMR ID without the 2 digit hotspot ID. 

@ QRG: Choose 0. 

@ Enable At Start: Check this box if you want it enabled at startup.

@ DMR Type: Choose BM if you want to use Brandmeister, or DMR Plus if 
you want to use DMR Plus with the QuadNet Array. I prefer the DMR Plus, 
as it appears to be more reliable than Brandmeister, especially if using TGIF, 
and its talk groups.

@ No Inband Data: Leave this box unchecked for Brandmeister.

! Brandmeister:

@ DMR Master: Choose the desired one (for your country’s location).

@ Master Password: With the DMR Brandmeister Servers, if you’re using 
hotspots, you can NOT use passw0rd as the default password. Instead, you 
MUST logon to the Brandmeister page, and go to the Self Care Panel, to 
create a new password, which should be DIFFERENT than the one you use to
logon to the Brandmeister page. Full details are available at:

https://news.brandmeister.network/configure-a-security-password-for-your-
hotspots/ 

https://news.brandmeister.network/configure-a-security-password-for-your-hotspots/
https://news.brandmeister.network/configure-a-security-password-for-your-hotspots/


Note: Brandmeister Talkgroup 31012 is NO LONGER AVAILABLE on the 
QuadNet Array, due to various issues...use DMR Plus instead. Brandmeister 
Talkgroup still works elsewhere, but NOT anymore on the QuadNet Array.

! DMR Plus:

If using this mode, select the Master Server desired. I personally use the 
IPSC2-QUADNET, for the QuadNet Array...as I do most of my nets there. 
You may wish to use one closer to your area. Details on the QuadNet Array 
are toward the end of this document.

With the Blue DV program; to use DMR, click on the DMR button in 
BlueDV, and then click on the AMBE tab, and find the Reflector box, located 
in the AMBE Tab, and type in the number of the reflector you want to use. 
such as (91 or 3100, etc.) 

Then, click on the transmit button for two seconds to go to that room. Now 
you can use that reflector. To exit the reflector, type in 4000 in the DMR 
reflector box, and press xmit to unconnect to a reflector (this is known as a 
4000 disconnect).

**

! Fusion: 

@ QTH Location: Enter your grid square. To find your grid square entry, go 
to http://www.levinecentral.com/ham/grid_square.php 

@ Enable At Start: Check this box if you want this mode enabled at startup.

@ Default Reflector: Choose YSF (Yaesu System Fusion) or FCS, then enter 
the desired values. 

For Fusion, Just click on the Fusion Button, and in the reflector box pick a 
room that you want to use and click on it. On either one, just click on the 
transmit button on the lower right of the program (AMBE3000) to transmit.

***

http://www.levinecentral.com/ham/grid_square.php


! AMBE:

This is mainly for use with a device like the ThumbDV from Northwest 
Digital Radio, or the DV MegaStick30 from GigaParts in the US.
@ Use AMBE (ThumbDV/DV3000). Check the box if you will use this.

@ Model AMBE: Enter your AMBE Model number.

@ Serial Port: Enter the port that the ThumbDV is on.

@ DMR ID: Enter your DMR ID (without the 2 digit hotspot ID).

@ Baud Rate: Enter 460800. See the note on baud rate settings on the next 
page.

@ Use AMBE Server: I have this box unchecked.

@ Host/IP: Enter the address for this on your LAN.

@ Port: I have 2460.

@ Start/Stop Beep: If you want the program to beep when a transmission 
starts or ends, check this box.

@ Kill Timer: This is in minutes. This is likely the max transmit time allowed.
Note that repeaters or reflectors can timeout in 3 minutes or less. Hams love 
to talk...and even yours truly can get long winded at times...needing to come 
up for air (hi hi).

@ DSTAR/C4FM Text: You can enter anything you want, up to a max of 15 
characters. Any more than that, and it won’t show up when you transmit. 

**

Baud Rate Settings:

From Gary, VE3DZ, you should also check your “Device Manager” under 
Windows. When you find the comport that your ThumbDV or DV Megastick 
30 is on, see if the system will allow you to change the comport value from 



9600 to 460800. I discovered with the DV Dongle and its cable that it would, 
but that on both Windows 10 and 11, neither the ThumbDV or DV 
Megastick30 would allow such a value. 

Here are the screenshots for that (from Windows 10 or 11).





Note
that this may NOT work with your setup...if the value won’t show a value of 
46800, leave it at the default, which is 9600. As noted, this will NOT work with
Windows 11 with the ThumbDV or the DV MegaStick 30.

If you’re running Windows 7 or earlier, from the Start Menu, choose Settings 
→ Control Panel → Device Manager. Then, you should see something like the 
screenshots with 4 and 5 on them. Click on APPLY to save the values.

! PTT Keying:

@ Enable: Check the box if you want this enabled. If using such, choose the 
serial port, RX indicator (RTS, DTR, and High or Low), and the PTT Button 
(CTS, DST, and High or Low). If you’re ONLY using the ThumbDV, this does
NOT need to be enabled.

**

When done, click on SAVE. You can ONLY change these settings in the setup 
mode. Now, enable the Serial switch, then select either DSTAR, DMR, or 
Fusion, and follow the instructions noted above. For D-Star, you can choose 
REF (US Trust Server Reflectors), or the XRF, XLS, or XLX/DCS reflectors. 



Testing Your Signal:

The FCC does allow testing of your signal, especially considering Windows 
has a nasty habit of stealing sound card ports, etc. If you have more than one 
sound card application, make sure you adjust the settings to the desired ports 
for audio.

If you have a webcam and a headset mic, make sure that your Sound settings 
are set the way you want them. The mic with a webcam can be different than 
with a headset mic, and the audio may be different as well. Note that if you 
“don’t want to be seen” via the webcam, use a different mic source (such as a 
headset mic). And, if you don’t care if you’re seen, be sure you’re “decently 
attired”, or have something secured to the front of the webcam. In short, I 
wouldn’t be operating “commando” (naked), as if you stand up, if your 
webcam is activated, everyone will see you in your altogether...even if you’re 
“naked as a jaybird”!!

As a side note, on a train trip from Arkansas to Oregon back in 1994 (I took 
Amtrak to and from the National Square Dance Convention ®, one of my 
other hobbies), I was monitoring a repeater in Wisconsin via my HT (this was 
long before D-Star, DMR, Echolink, Fusion, etc.), and was “reading the mail” 
on a QSO. This one ham had just gotten out of the shower, and he was “naked
as a jaybird”. He was ragchewing with the hams on frequency, then said “I 
need to get dressed, as my wife and I are going out for dinner tonight”. He 
then gave his callsign to sign off, and said he was clear of the repeater. One of 
his buddies then quipped “I’ll bet you didn’t know I had one of those ATV 
(Amateur Television) Units that lets you see who you’re talking to!!”. I about 
fell out of the Sleeping Car compartment, as I was laughing so hard!! (hi hi).

From Grady, W4GLE: “Most REF Reflectors (such as REF 058) have a Echo 
Node. All you have to do is go to REF058E, key up and give your callsign and 
say "TESTING". This is available on most of the REF Reflectors, I do know 
it will work on REF058, REF030, REF029 and others.”

With the BlueDV program, you adjust the audio settings with the AMBE 
navigation bar. Click on the AMBE tab, and you’ll see four settings...VOX, 
Fusion Gain, DMR Gain, and DSTAR Gain. 



With the VOX, if you want to use it (it’s NOT recommended, as it can pick up
every little sound from your shack), you’ll check the VOX box. It has a hang 
time and vox level slider that you adjust to your liking. With Fusion Gain, 
DMR Gain, and D-Star Gain, you have spk (speaker) and mic (microphone) 
gain, all adjusted with sliders. There is a VU Meter with the AMBE 3000 (if 
you have that setup), that shows the audio level, but the meter isn’t perfect. 
As noted elsewhere in this file, Windows is notorious for skewing audio 
settings.

Once you exit Setup, on the top navigation bar (as noted in the screenshot at 
the top of the next page), you’ll see Menu, Update, AMBE, and About. Before 
you connect to D-Star, DMR, or Fusion, click on AMBE, and set those to your 
desired speaker and mic, such as a headset mic. Then, go into the Sound 
settings (the volume and speaker icon in the task bar in Windows) and change
the settings there, if needed (they should match). 

Otherwise, you’ll have the sound through the computer mic, and it may sound
“tinny” and distorted. Also, if you have a webcam and associated microphone,
the audio can be markedly different than with a headset mic, or the computer
microphone. Om the next page is a screenshot of that AMBE Window, taking 
during the Texas D-Star Net, which meets every Tuesday, at 8pm Central 
Time, on Reflector 4B, with Roy, WJ5Z, as Net Control.



Unfortunately, I could not get a screenshot of the AMBE window where you 
set the speaker output and mic input. A headset mic is better than a computer 
mic, especially if it’s a USB mic. This is from a previous version, but it should 
still work/apply.

**

D-Rats Overview:

With D-Rats, the next several items are screenshots from my D-Rats setup, on
a Lenovo laptop, with Windows 11 64-bit. If you upgrade from Windows 10 to
Windows 11, no re-installations are needed. Customize these to your setup.

All of the items start with the F)ile → Preferences command, and work their 
way down. The data and screenshots with Email or Winlink 2000 (WL2K) is 
NOT included, as it’s best to send email via your regular email client (such as 
Gmail), and Winlink Express (for WL2K).
 
The original version of D-Rats was done by KK7DS, but development on it 
stopped awhile back. Thankfully, it was open source…and recently, YO2LOJ 
and IZ2LXI have taken on development, and have restored functionality to 
several items that had “broken” (such as the Maps viewer and Weather Data 
in the QST’s – details on both are later in this file). 

For 64-bit operating systems, the LZHUF utility is included in a separate 
folder with the new builds. The latest version is D-Rats 0.3.9 – and is available
in the file section of the d-rats group on groups.io – the build was done for XP,
but it works under both Windows 10 and Windows 11 64-bit. 

Note that Microsoft won’t provide security updates prior to Windows 10 
(unless you pay them a large amount of money), and it’s highly recommended
that you upgrade to Windows 10 or 11. Most Windows 10 computers are 64-
bit – and unless the CPU is designed to accept 32-bit operations, you can’t 
even install a 32-bit operating system OS (I found that out trying to upgrade 
the computer for my computer BBS). Microsoft will support Windows 10 
through early October, 2025. Beginning with Windows 11, it’s a 64-bit OS 
only; 32-bit support ENDS with Windows 10. There is a utility where you can 
run 32-bit applications on a 64-bit system. 



Details are at https://github.com/leecher1337/ntvdmx64. Note that there may be sound 
card issues with Windows 11, versus Windows 10, and with the ThumbDV, 
DV MegaStick 30, and the BlueDV program.

With needing copies of the Windows 10 32-bit OS, when I had to upgrade my 
computers from Windows 7 32-bit, I decided to order the DVD’s from Best 
Buy, but it took around 2 weeks for them to arrive. I preferred to pick it up 
directly from the store, so someone didn’t steal it off of your porch, or out of 
my mailbox. Plus, ordering it from Best Buy was nearly $100 cheaper than 
ordering it from Microsoft!! If you have Windows 10 64-bit already, the 
upgrade to Windows 11 64-bit is free of charge.

Most of the categories that are noted below will be self explanatory. While 
some of my listings are noted in the screenshots below, obviously, you will fill 
in and customize the values for your own system. These include your callsign, 
comports, various ID’s (DMR), info settings with the BlueDV program, 
among other things.

Quick Start For D-Rats:

I’m using the file that was done for Windows XP, but it works with Windows 
10 or 11. Again, note that Windows 11 is 64-bit only. You will extract the 
directory that is inside the zip file to the directory Program Files (x86). The 
file is available from the d-rats forum on groups.io

First, for those who want to get on the air quickly, here is a “Quick Start” 
guide for getting started with D-Rats, courtesy of Patrick Connor, N3TSZ.
These will be covered in further detail later in the file. If you are new to D-
RATS, set up these items first. Press [ALT+P] to open the config window.

1. Under Preferences, be sure your callsign is correct. Personalize the Sign-on,
Sign-off and Ping reply messages. As noted elsewhere in this document, a 
Secondary Station ID (SSID) is OPTIONAL. Most stations just enter their 
callsign ONLY.

If you are running D-Rats on 2 different computers, you will need to use a 
SSID on both – I use WX4QZ-1 on my Windows 11 laptop, and WX4QZ-15 
on the Windows 10 desktop computer, when I’m running the Arklatex D-Star 

https://github.com/leecher1337/ntvdmx64


Net on Tuesday evenings. Normally, only the WX4QZ-1 station is 
active...unless the computer is offline for whatever reason.

2. Under GPS, Set your latitude and longitude. There are GPS apps and even 
websites for you to get your exact location.

3. Under Appearance, type your callsign on the Notice Reg Ex line.

4. Under Chat, change the font and size for easier reading, to suit your taste.

5. Under Sounds, assign .wav files for each event. Note that this option is not 
available on Linux distros.

6. Under Messages, enable "Automatically Forward Messages". Set Queue 
flush interval to 30 seconds. Set Station TTL to 600 seconds.

7. Under Transfers, enable "Remote File Transfers". Set Warmup Length to 
16. Set Warmup Timeout to 0.

8. Click Save to close the config window.

9. Personalize the My Status message in the lower right corner of the Main 
window. Delete the text, and insert your own (e.g. Myname in City, State, 
[Locator]).

You can also access the d-rats forum on groups.io for more information.

Using D-Rats With Your D-Star Radio (courtesy of Glen, KG5CEN):

I have been using D-Rats through the ID92AD. You’ll need to know the 
following settings and have them set in the radio. The baud rate is already set,
but you must go into your menu to configure the others. If you set the baud 
rate wrong in D-Rats, the computer will not be able to communicate with the 
radio. You need to use the proper data cable to connect to this radio. If you 
have the programming cable from RT Systems or the Icom data cable, one of 
those should work:

ID-92AD – Baud rate=38400, DV DATA TXT = AUTO, GPS-TX=Disabled, 
GPS AUTO TX=OFF



The older HT’s were the only radios that used such a high baud rate. The ID-
5100 for example, only uses a baud rate of 9600. If you set the baud rate 
wrong in the software, the computer won’t talk to the radio. 

Also remember, most of the D-Rats ratflectors are operating in Internet-only 
mode for people to practice on, and to have access to certain files and 
emailing. We only would connect a ratflector to a radio during emergency 
situations when we wanted to use it as a bridge between RF and people 
accessing from the Internet. In an area where the Internet is out, and you’re 
just trying to contact other local stations working the emergency event, a 
ratflector is not needed to communicate radio to radio. 

The reason for this is that most of us don’t want to tie up a computer and an 
expensive D-Star base station to keep up an RF-accessible D-Rats station 
when there is nothing else going on. Many repeater and reflector operators 
would get upset if we had a D-Rats station constantly tying up their system 
when no emergency was in progress, unless they have a D module. Many 
repeater sites only have A, B, and C modules running, and some stations 
using Pi-Star will only have one mode available. 

If the D-Rats station starts transmitting, the repeater will show as busy with 
nothing being heard, and usually, he won’t have anyone else to talk to. If you 
connect to a ratflector, and are on RF at the same time, the signal will go out 
both ways. The best way to test to see if you get your station working is to 
have another D-Rats user or an RF-connected ratflector in the area. However,
if you just type TEST on the chat line and hit send, if you see the radio 
transmit, you will know that it is working.

In addition to sending digital voice, DSTAR radios have the capability of 
concurrently sending a low-speed data stream. The original intent behind this
was to send GPS position data to other DSTAR radios. Optionally, the GPS 
feature may be disabled, and an external serial data connection can be made. 
The DRATS program makes use of the external data connection.

First, set up your radio for low-speed data operation per your radio's 
Instruction Manual. That usually consists of:

! Turning off GPS TX



! Setting DV DATA TX to Auto

! Some radios let you change the speed of the serial port. Take note of the 
setting as you will need to know it when creating the connection in DRATS 
preferences.

! Turn off the TX message on your DSTAR radio as it uses bandwidth that 
could be used to transmit DRATS data.

! Turn off the power save features on portable radios.

Next, connect your radio to a serial port on your computer with a data cable.
The ID800 uses a cable with a plug that looks like a PS2 connector with 8 
pins. The IC92AD sends data through the mike jack. All other radios use the 
cable with the 2.5mm plug on the radio end.

Finally, make a connection in DRATS:

Click on File → Preferences → Radio → Add
Name = Your choice
Type = Serial
Serial Port = The COM port where your radio is connected
Baud Rate = Speed of the serial port connection to your radio
Click Add
Move down the tree to Transfers
Make Warmup Length = 16
Make Warmup timeout = 0
Click Save to exit preferences.

Click on the dropdown arrow to the left of the typing box and select the 
connection you just created for your radio. All Chat and QSTs will now be 
transmitted through this connection. Be aware that all enabled connections 
receive incoming traffic. If you wish to “quiet” any connections you are not 
using, go to File → Preferences → Radio, and disable them.

Multiple Monitors:

It’s beneficial to have multiple monitors set up...because when using a single 
monitor, things can get “crowded”!! I use a program on my Windows 11 64-



bit laptop called Display Viewer...which allows such. You can find information
on the program at https://binaryfortress.com/support – now, if I’m running a 
net with the taking of D-Rats checkins, I’m on D-Rats on the St. Tammany 
Ratflector (thanks to Glen, KG5CEN, for the use of that ratflector during my 
nets). Also, if the net has a Facebook group, I log there as well. And, to top it 
off, I use Netlogger (next paragraph). 

Netlogger With Nets:

Netlogger is a fantastic program, for Windows, Mac, and Linux. It’s a great 
way to increase the visibility of your nets as Net Control...or for nets to 
checkin to. You can get it at https://www.netlogger.org – I’m using NetLogger 
for logging of my nets, as it’s much easier than trying to log with Windows 
Notepad; because with one slip of the keystroke, you can delete everything in 
the file!! Please see the separate PDF file for “Setting Up Netlogger With 
Nets” for more details, and appropriate screenshots. 

Note that I don’t use Netlogger for contesting or contacts (those modes never 
did appeal to me)...but that option is available for those who want it. Also, a 
quick guide for the “checkin/status colors” is available from the hyperlink on 
my QRZ bio. 

Also, those colors are “hard coded” with Netlogger, and can’t be changed. 
However, you can use as many or as few of these color codes as you desire.

Now, here is a step by step setup for D-Rats, starting with screenshots on the 
next page.

Note that since I don’t use the Winlink 2000 or email capabilities with D-Rats 
(I prefer to instead use the Winlink Express program, and Gmail through my 
web browser), I do NOT cover the setup of those items in this file. 

The original information and tutorial files that Lew, KB5HPT, had created, 
have out of date info on the Gmail and Winlink 2000. To me, using the 
separate programs for email and Winlink 2000 gets the job done much better.

https://www.netlogger.org/
https://binaryfortress.com/support


File → Preferences

Enter your ham radio callsign and name (most stations just use their first 
name). Obviously, where my callsign and name are is noted, you would 
substitute yours. 

Note that a secondary station ID (SSID), such as WX4QZ-1, is optional; as 
most ham radio operators just use their callsign only. Plus, most stations only 
have one station online at a time. But, if you also have a packet station, an 
APRS setup, etc., an SSID is appropriate. Concerning SSID’s, related to 
APRS, you can find information at this website:

https://www.jpole-antenna.com/2018/09/25/aprs-ssids-paths-and-beacons 

A background/history on SSID’s can be found at http://www.aprs.org/aprs11/SSIDs.txt 
Bob Bruninga, WB4APR, pioneered the Automated Packet Reporting System
(APRS) (sadly, he became a Silent Key recently). You can have your “ID” 
from D-Rats show up on the APRS-FI website at https://aprs.fi with a special 
QST from D-Rats. Details will be later in this document. As noted earlier in 
the file, if you’re using the BlueDV program from PA7LIM, two red 
rectangles on the lower left, means that you have an APRS chat from 

https://aprs.fi/
http://www.aprs.org/aprs11/SSIDs.txt
https://www.jpole-antenna.com/2018/09/25/aprs-ssids-paths-and-beacons


someone...as noted in the screenshot below. This is from a previous version, 
but it should still apply.

Next enter your messages at sign-on and sign-off, and what you should send to
stations who “Ping” you. Most note what operating system they are running, 
or a special URL to find files if their D-Rats station is down/offline...which is 
recommended during thunderstorms (no amount of surge protection will stop
damage from a direct or very close lightning strike). 

Choose whether you want Imperial (used in the United States) or Metric 
measurements (used in much of the rest of the world). Note that the ham 
radio bands are termed in metric...plus weather data in the United States and 
around the world, is done in metric. This will be noted in the weather data 
display in D-Rats, discussed later in this file. 

Then, choose whether you want to blink the program in the system tray for 
incoming messages, new chat messages, incoming files, and received events. 
This will also occur when a station connects or disconnects...so, as fast as you 
click on it to stop it from blinking, it may start blinking again. So, I don’t use 
the option to blink for new chat messages...since I can just monitor things 
with the chat window.



File → Preferences → Paths

For the D-Rats Shared Folder, it’ll create a folder named “D-Rats Shared”.
If it does not, it’s best that you create one yourself on your desktop. Any files 
that come to you from other hams should be viewed from that folder, and not 
from within the D-Rats Files Area (within D-Rats) itself. That is the path you 
should place in that first box. Otherwise, you are less likely to find the file. 

It’s also best to keep a list of what files you have in there, so if a new one 
comes in (this data can be found in the logs), you’ll know that someone else 
uploaded it. This area should also be where you have your system anti-virus 
utilities able to scan and remove any malware...from this folder, or any other 
location on your system. Obviously, you should keep the anti-virus and anti-
ransomware software updated. 

While there are several anti-virus programs available (McAfee, CA Internet 
Security, F-Prot, AVG, and Malware Bytes, among others), I use the IObit 
Malware Fighter, and other utilities from IObit Software. Their website is at 
https://www.iobit.com 

https://www.iobit.com/


You may also need utilities like a reader for PDF files (Adobe Acrobat, Fox-It,
etc.), Microsoft Office, LibreOffice, or OpenOffice, for Word, Excel, etc. files, 
a viewer for JPG, GIF, PNG, and other graphics files. 

The Fox-It PDF Editor, while expensive, was half the price to register 
compared to Adobe Acrobat. If you don’t need an Editor, the PDF Reader 
from Fox-It works nicely. For just simple textfiles, a simple text editor, such 
as Windows Notepad, is sufficient.

Note that the original MS-DOS Editor will NOT work under 64-bit versions 
of Windows, as there is no NTVDM module under 64-bit, as there is under the
32-bit version. So, you have to use either Notepad, Word, Microsoft Office, 
LibreOffice, or Microsoft Office for text files on the 64-bit systems. 

As noted earlier, 32-bit support ENDS with Windows 10. Leave the other 2 
paths as they are, once you’ve installed it on your system, unless you change 
the paths for them – however, the default paths work just fine. 

Note that the AppData\Roaming\D-RATS\EV folders are HIDDEN. You will 
have to set Windows Explorer or File Explorer to “show hidden files”. The 
configuration file is in that folder. 

If you want to (or have to) do a full reinstall of D-Rats, exit the program first, 
then go into that folder, and DELETE the CONFIG file, and do a full re-
install. This is what needs to be done if D-Rats “crashes” instantly upon being
loaded. It basically is where you just go in and delete the directory that D-
Rats was placed into in the first place, to make sure it’s a clean, fresh install.

At times, under Windows 11, the File Explorer program crashes quite a bit. 
Then, you have to wait for the display and icons to reset and reload.

There is an alternate freeware program called Explorer Plus Plus. It’s 
available at https://explorerplusplus.com – while it operates differently than 
File Explorer, I’ve rarely had that program crash on me...and I don’t have to 
wait for the screen and program shortcuts to reload.

File → Preferences → Maps

https://explorerplusplus.com/


This feature, which was originally in the original version done by KK7DS, 
had “broken”. But, with development being taken up by IZ2LXI and 
YO2LOJ, this feature is working again. 

You will need to get your own API key to put in the “blank windows” in the 
screenshot noted above. Go to www.thunderforest.com – and sign up for the 
Hobbyists package...it is free of charge. The fee is based on the number of API
hits each month. You’ll be first sent a validation email, then the api key you 
will need (place it in the setup where the blank boxes are noted above), with a 
subsequent email. Leave the other 2 items as they are. 

There are 4 “map themes” available...including “base” (the one I’m using), 
“cycle”, “outdoors”, and “landscape”. Note that if you are having problems 
displaying the maps, CHANGE the URL from https to http – leave the rest of 
the URL the same. This is the case if you want to use the “cycle”, “outdoors”, 
or “landscape” maps instead of the “base” map. I’m using the Base Map for 
now. A screenshot of my location in southwest Little Rock at Zoom Level 12, 
is below...then a wide view (Zoom Level 5) is on the following page. It gives 
you an idea of what these zoom levels will look like. At the bottom, you can 
check the stations you want show up, and uncheck those you’re not interested 
in. You can also minimize that window while D-Rats is running. 

http://www.thunderforest.com/


I’m 1/4 mile from the Union Pacific (formerly Missouri Pacific) Railroad 
mainline, which is what Amtrak’s Texas Eagle passenger train uses between 
Saint Louis, Missouri, and Dallas, Texas. It then changes to the former Rock 
Island trackage between Dallas and Fort Worth, which the Trinity Rail 
Express uses. By using this route, it eliminates a time consuming back up 
move into and out of Fort Worth. 

With the map view (on the next page), you can check the box to view the 
stations on the map. You can display them by checking or unchecking various 
boxes. Obviously, if you check them, they will show up on the maps...and if 
you uncheck them, they won’t display on the maps. However, they may still 
show up in the regular station listing. You can sort these by clicking on the 
information on the “Show” Line of Station, Latitude, Longistute, Distance, 
and Direction”. If the arrow to the right of the indicator is pointing up, that’s 
your “sorting priority”. You can also adjust the zoom level. Note that by 
“zooming out”, the  “actual location” of the station may be skewed on the 
map display. 



File → Preferences → GPS Config
 



Enter your latitude and longitude data. You can get it on the internet, or from
various smartphone apps. Be sure that if you’re in the United States, that the 
longitude has a minus sign before it...or you might appear to be in the middle 
of the ocean!! If you know your altitude, enter it. If you use an external GPS, 
check the box, and enter the desired data. For the GPS symbol, the Table 
symbol of / and the Symbol of the “close parenthesis” ) was what it was on my
original setup (with the version that KK7DS did). Click on DPRS, and enter 
the desired symbol for your location.

For my location, since I am fully disabled (and have been since 2004), I use 
the “Handicapped Wheelchair” symbol. Unfortunately, they keep finding 
stuff wrong with me. 

File → Preferences → Export GPS messages

If you wish to export these as a JSON string, check the box, enter your IP 
address, and the port (5011). You will need to configure your internet router 
for the setup, if using this option. 

If you are using a LinkSys router, enter 192.168.1.1 in the navigation bar of 
your web browser to get to the router control panel...then enter the password 
to login, then go to Security, and Port Forwarding to set it up. 



WARNING!! If you don’t remember the router password, you’ll have to “do a
hard reset on it”. Bear in mind that any previous port settings, passwords, 
configurations, etc., will be erased with the reset. 

If you have a router besides LinkSys, check the program documentation for 
the needed address to get to its “control panel” via your web browser. I 
personally am NOT using this option in my setup.

File → Preferences → Appearance 

Below is the graphic where you set your notification colors, and strings for 
special filters. Pay particular attention to the Notice RegEx and the Ignore 
RegEx windows. If you enter this data incorrectly (especially with the Ignore 
RegEx window), D-Rats will crash each time you load it, and you’ll have to 
delete the configuration file, and reinstall the program from scratch.

In this setting, this is how messages and your callsign will show up in chat. 
Your callsign will go in the first box, and be in the Notice RegEx box. In the 
Ignore RegEx box, this is how you will set up filters for QST’s and CQ 
messages, so they don’t show up in the chat window. These come in fairly 
regularly, and without these filters, your chat window will fill up fast!!



Again, you MUST enter the data in Ignore RegEx EXACTLY as it’s shown, 
for these 2 filters. Otherwise, D-Rats will CRASH when you try to load it, and
you’ll have to delete everything, including the directory where you installed it 
originally, then reinstall the entire program from scratch. It should be entered
as:

\[QST\] \[CQCQCQ\] 

This would be backslash, left bracket, QST, backslash, right bracket, space, 
backslash, left bracket, CQCQCQ, backslash, right bracket.

Change the colors to your liking. Then, choose the size of the toolbar buttons.
If you wish spelling to be checked, or to confirm when you exit the program, 
check the boxes. Then, set the expiration value for stations. Once that value is 
reached, they won’t show up in the stations window, as they will be termed as 
inactive. The default expiration time is 60 minutes, but I’ve had it set as low 
as 10 minutes, which is normally the time one has to “legally ID their station” 
in the US and its territories.

If you are the ratflector owner, and not just “an end user” connecting to the 
particular ratflector...if you have a station with constant “flooding of the 
ratflector” with QST’s and CQ’s – besides the filtering method noted above, 
there is another way to block them, with “Authentication”.

From page 5 of the documentation at:
 
http://www.d-rats.com/download/doc/contrib/Running_your_own_ratflector_
0.3.3.pdf 

If you decide that you need a minimal level of security in the form of rejecting
casual users, you can enable authentication on the proxy. This will require 
people to configure D-RATS with a password in order to connect. To do this, 
create a text file in the working directory of the repeater called users.txt and 
place lines such as the following inside:

 KK7DS foobar
 K7TAY girlie

http://www.d-rats.com/download/doc/contrib/Running_your_own_ratflector_0.3.3.pdf
http://www.d-rats.com/download/doc/contrib/Running_your_own_ratflector_0.3.3.pdf


The format of the file is one record per line, each line is the callsign followed 
by a space, followed by the password that user must supply. If the user does 
not supply this password, then they will be BLOCKED from posting data to 
that particular ratflector.

On Windows, this file, named users.txt -- should go in C:\Program Files\D-
RATS -- unless you installed D-RATS to an alternate location. On Linux or 
MacOS it will go in the directory from which you spawn the repeater.

Again, this is only if you run a ratflector...I don’t think that this will work if 
you are just “an end user”. In this case, the previously noted filters for QST’s 
and CQ’s, will have to suffice.

File → Preferences → Chat

(the graphic and instructions are on the next page)

 

 
If you wish to log the chat traffic, and to load the log tail, check the desired 
boxes. For the Chat Font, choose the desired font, the size, whether you want 
it standard, bold, or italic print. Times New Roman, Bold, Size 12, works for 
me. 



For the scrollback lines (how far you can go back in the data on the screen), 
1024 lines should be sufficient, but change that to your liking. For the 
showing of status updates in chat, it’s recommended that this box be left 
unchecked. Otherwise, every time a station signs on, signs off, or pings, all of 
that will fill up the chat window. You can check the box to timestamp the chat 
messages. Lastly, for the QST size limit, I recommend that be set to 4096.

Since the WeatherUnderground deal no longer works in D-Rats, you can go to
https://www.openweathermap.org to get a free api account for the weather 
data. I would recommend setting it to display only once an hour. You insert 
your own API ID in the string. The screenshot for this is on the next page.

Note that if you are having trouble displaying the OpenWeather forecast for 
the area desired, CHANGE the URL from https to http – and leave the rest of 
it the same. You will still need to enter your API ID in the box noted.
The graphic in the QST window (noted below) is how you’d set it up. The city 
and state MUST be in lowercase, or it won’t work. As a side note, I modified 
my screen colors, so that’s why the top of the window appears as “orange”. 

 

Since I mainly am on the St. Tammany Ratflector, this is how the data looks 
when it is sent...but it comes directly on the ratflector, instead of the QST 
window, even though it is is a QST. Data is either for “Current” (the last 
weather observation for the station) or “Forecast” (forecast for the next 5 
days)...choose which one you want displayed (I have “Current”). 

https://www.openweathermap.org/


The weather data is done in Metric Units (Celsius or Centigrade for 
temperature, hectopascals or millibars for barometric pressure, and then 
kilometers per hour for wind speed). The National Weather Service does all 
their data in the metric units already.

You can convert these to Imperial Units (Fahrenheit, inches of mercury, and 
miles per hour, respectively), by going to:

https://www.wpc.ncep.noaa.gov/html/calc.shtml 

Then, click on the desired link. You can also calculate relative humidity, wind 
chill, and heat index readings, at the above URL. Also, in the chat window, 
you can highlight the desired text with your mouse (move the cursor to where 
you want to start, hold down the left mouse button, and scroll to the end of 
the text). Then, right click, and choose “Copy”. Next, open up a program such
as Windows Notepad, then click Edit → Paste. Your captured text will be 
pasted into Notepad (or whatever utility you choose), and you can then save 
the file to whatever name you desire.

https://www.wpc.ncep.noaa.gov/html/calc.shtml


File → Preferences → Sounds
 

If you don’t want any sounds from your system, you can either MUTE all the 
sounds with the Control Panel, the volume control on your keyboard or 
taskbar, or just leave the fields blank. 

On muting of sounds, this is especially important if the computer where your 
D-Rats is in located in your bedroom, and you don’t want strange noises 
awakening you from a sound sleep...or if you’re in the middle of a net, and 
don’t want strange noises coming through your speakers or headset mic. You 
could also check the mute button in your system taskbar, if desired. 

If you want certain sound effects for Chat, Message, or File Activity, select the
desired file (WAV, MP3, etc.), and click ENABLE. As noted by Patrick 
Connor, N3TSZ, this option is NOT available with Linux distros. 

While “dirty old hams need love, too” (hi hi), I recommend that you keep the 
files basically “clean”. Admittedly, with friends like us (amateur radio 
operators), you don’t need any enemies (hi hi).

File → Preferences → Messages



This section is mainly if you’re using the Winlink 2000 (WL2K) feature of the 
program. However, I personally recommend that you use a separate program 
such as Winlink Express, which is a shareware program. The cost to register 
is reasonable, and it supports further development. You can download the 
program, get more information, and register it, at https://www.winlink.org 

Because of security issues, WL2K * REQUIRES * a password to access. And, 
for the subject, you MUST enter //WL2K-- I think that’s the settings, but I am
not sure...as I haven’t used this feature for so long in D-Rats...because, as 
noted noted above, I use Winlink Express.

Also, I tell the software to connect to a CMS via telnet, since I have no RF 
gear at the QTH. My email is wx4qz@winlink.org – this is checked weekly. 
However, my personal email of wx4qz@arrl.net is checked several times a 
day.

If you do change your callsign, you can get a new registration key free of 
charge. Note that if you don’t access the system for a year, your callsign and 
account are changed to INACTIVE status. If this occurs, you’ll have to 
contact the support staff to get these items reactivated for use. 

Again, as noted earlier, as of April 19, 2022...a vanity callsign change, or 
either a new or renewed amateur radio license in the US and its territories, 
will require payment of a $35 fee to the FCC, before these will be granted. 
The fee does NOT apply to license class upgrades, sequential callsign change 
requests, or administrative changes (change in name, email or mailing 
address, or club trustee). See https://www.arrl.org/fcc-application-fee for 
more information.

The one box I’ve checked on that screen is “include original in reply”. This is 
used for email messages to users who are online at the time. As a result, I have
not included that screenshot here. I normally will manually insert a “greater 
than” > sign, for the parts of the message that I’m quoting, and do around 40 
characters per line in my reply to the other station.

File → Preferences → Radio

https://www.arrl.org/fcc-application-fee
mailto:wx4qz@arrl.net
mailto:wx4qz@winlink.org
https://www.winlink.org/


This is where you set up the various ratflectors to access. You can set it to use 
a serial/comport connection if you’re connected to your rig; or to a network 
connection if you are “internet only”...which is described below.

First, click on ADD. Then, choose NETWORK. For the name, enter whatever 
you like...although a using only a callsign or name is usually sufficient, such as
what’s in the screenshot from my setup noted above. 

Basically, make it for what’s easy for you to remember. Again, some nets use 
D-Rats during “the voice net”, while other nets are strictly “D-Rats Only”.

Then, for the address, enter the address of the ratflector. This will be what is 
after each “net:” noted in the screenshots on the following pages. The port in 
most cases, is 9000 (leave the password field blank). Then, click on Save. 
Repeat this for every ratflector you want. I am not sure how many ratflectors 
that you can put in D-Rats.

Here is a list of ratflectors as of Oct. 1, 2021. Note that I have VERIFIED that
each of these are online. I’ve provided the name that I use (you can choose to 



use another name if desired), but the network address must be as noted. I 
don’t know how many ratflectors D-Rats will allow to be setup. 

       D-Rats Ratflector Name:           D-Rats Ratflector Address:

AE5HE (El Paso, Texas)                   ae5he.ratflector.com
Alabama                                             alabama.ratflector.com
W5AW (Big Spring, Texas)               w5aw.ratflector.com
Tennessee                                            tn.ratflector.com
Georgia ARES                                    gaares.ratflector.com
KB8PMY                                            kb8pmy.net
Paulding County Georgia ARES      pldares.ratflector.com
Santa Fe, New Mexico                       w5sf.ratflector.com
Southeast US Weather                       sewx.ratflector.com
Saint Tammany, Louisiana                sttammany.ratflector.com
WA7DRE (Spokane, Washington)    d-rats.wa7dre.org
Wisconsin                                            kc9sjy.asuscomm.com

Of the ratflectors noted above, these are used during the following nets:

Digital Radio Enthusiasts Morning Net, 7am Pacific Time Monday through 
Friday, on Reflector 29A. On D-Rats, use the WA7DRE Ratflector. There is 
no “morning net” on Reflector 29A on the weekends (Saturday and Sunday), 
US Time.

El Paso D-Star Net – Monday, 7:15pm Mountain Time, on Reflector 55A. On 
D-Rats, off of the AE5HE Ratflector, go to the El Paso Chat Room. Details on 
setting up the Chat Rooms are later in this document.

Arklatex D-Star Net – Tuesday, 7:30pm Central Time, on Reflector 48 B. On 
D-Rats, use the Saint Tammany, Louisiana Ratflector.

Alabama D-Star Net – Tuesday, 8:30pm Central Time, on Reflector 58 B. This
is the ONLY way to get a early checkin for this net. On D-Rats, use the 
Alabama Ratflector. The D-Rats checkins begin at 8pm Central Time.

New Mexico D-Star Net – Thursday, 8pm Mountain Time, on Reflector 55A. 
On D-Rats, use the AE5HE Ratflector.



Memphis Digital Amateur Radio Club D-Star/D-Rats Net – Friday, 8:30pm 
Central Time, on Reflector 58A. 

On D-Rats it doesn’t matter which ratflector you are on, but you need to go to
the desired chat room. Again, details on setting up the Chat Rooms are later 
in this file.

You can use as many or as few as these ratflectors as you’d like. If, upon the 
first loading of the program, if under the “Events” window, you see a message
that a certain ratflector won’t connect, it may be temporarily offline. 

With some of the ratflectors, whenever Microsoft Windows does an update, it 
does a system reboot; and the ratflector’s down until the administrator “logs 
on” and reboots the system, and resets the software. The Georgia ARES and 
the Southeast US Weather ratflectors both fall into this category.
 
File → Preferences → Transfers

You can use D-Rats to request files from other ham radio operators D-Rats 
stations...or have files available for other D-Rats stations to obtain from you.

On your desktop (again, I’m running Windows 11), there is a folder called 
“D-Rats Shared”. If you wish to view files that you have, do it via this folder. 
Do NOT try to view a file within D-Rats itself. 

Obviously, “practice safe hex”, and scan any incoming file for malware, 
ransomware, viruses, etc. – and be sure that any files you put in this directory
are free from such. A list of the utilities that I use from IObit Software are 
noted later in this file.

Acceptable file formats include the following...note that appropriate utilities 
to view and work with these (examples are listed) are required:

! PDF – Portable Document Format – Adobe Acrobat Reader, Foxit PDF 
Reader, etc.

! GIF, JPG, PNG – Graphics Interchange Format (originally created by 
CompuServe ™), J-Peg (JPG), and Portable Network Graphic (PNG). A 



graphics viewer is required, but most can be viewed with the Explorer 
program in Windows.

! TXT – Ascii Textfiles. A simple editor such as Windows Notepad is required.

! DOC – Microsoft Word ™ documents. Programs such as Microsoft Office, 
LibreOffice, OpenOffice, etc. are required.

! PPT – Powerpoint Presentations – Programs such as Microsoft Office, 
LibreOffice, OpenOffice, etc. are required.

! XLS or XLX – Excel Spreadsheets – Programs such as Microsoft Office, 
LibreOffice, OpenOffice, etc. are required.

! XML – Excel Markup Language Forms – Programs such as Microsoft 
Office, LibreOffice, OpenOffice, etc. are required. 

! ZIP, ARJ, RAR – Archived Files. Several files are “archived” within it. 
You’ll need a program such as WinZip ™, WinRAR ™, etc. to extract the 
files. Also, once these archives are extracted, they will take up additional 
space.

On the next page is the screenshot for the data for file transfers. With the 
emails, they are for TEXT ONLY messages...do NOT use HTML codes.

Note that I have NOT entered data with the File → Preferences → Network 
settings, including email. There is a way to do email with D-Rats, but it’s best 
to just use a separate email program, such as Gmail, HotMail, Yahoo, etc. for 
your email. 

With Gmail, you can file important messages in separate folders, and don’t 
have to worry about losing the data. 

With D-Rats, if you end up having to reinstall the program, you likely will 
lose any messages that you have previously saved. And, with email in D-Rats, 
it’ll send a message to stations who are online at the same time you are. 



Chat Filters:

If you recall the Ignore RegEx data earlier in this document, this is how you 
will set up the filters for it...for the QST and CQ filters. 

Under Chat, click on Add Filter (you will need to do this for both the QST 
and CQ filters). 

For QST, enter [QST] and press <ENTER>. For CQ, enter CQCQCQ: and 
press <ENTER>. 

Then, when a QST or CQ comes in, it will go into these “filters” and the text 
will turn red. Click on the button to view the QST’s or CQ’s that came in 
from other stations. When additional QST’s or CQ’s arrive, the text will again
turn red.

Information on setting up QST’s and Quick Messages are noted later in this 
document.

To remove the filter, click on Remove Filter...but be sure to remove that from 
the Ignore RegEx. However, I recommend you keep BOTH of these, as they 
come in quite frequently. The QST and CQ filters are the only ones I use.



Chat Rooms:

On some nets, there are “chat rooms”. It does NOT matter which ratflector 
you are on initially. As members in the chat rooms type comments, you’ll see 
their callsign, plus which initial ratflector they are on.

To join the chat room, click “Join Chat”, type the name of the room, and 
press <ENTER>. A hashtag # will appear before the room name that you 
entered. Click on that, and you’ll be in the chat room. 

The 2 rooms that I know of are as follows:
 
! El_Paso – The El Paso Chat room, used on the El Paso D-Star Net, which 
meets at 8:15pm Mountain Time on Monday...and on the New Mexico D-Star 
Net, which meets at 8pm Mountain Time on Thursday. The reflector for both 
nets is REF 55A. If the reflector goes down during the net, Lew, KB5HPT, will
try to reboot it (it might take 5 minutes). If that fails, the backup reflector 
that will be used will be announced by Net Control. It may be either REF 9B 
or REF 72A. The chat room is noted by #El_Paso in the status bar.

! Memphis – The Memphis Chat Room, used on the Memphis Digital 
Amateur Radio Club (MDARC) D-Star Net (the DARC side of digital (hi hi)),
which meets on REF 58A on Fridays at 8:30pm Central Time. This is noted 
by #Memphis in the status bar.

Private Chat Windows:

You can also set up a private chat room with another ham. 
Click on Open Private Chat, enter the desired callsign, and a window will 
open. For the ham at the other end, they will see an @ symbol, followed by 
your callsign. 

For example, if Jack, KD4IZ, were to start a private chat with me, I would 
have @KD4IZ show up in red on my status bar...and I click on that to open 
the window. At his end, the window would be @WX4QZ on his status bar; 
and he would click on it to open the window. 

I believe you can have more than one Private Chat Window at a time. When 
done with the chat, just choose “Remove Filter”, and click on that window.



Pings in Chat:

Normally, you can “ping” the status of an individual station, or all stations in 
D-Rats, to check their status. But, if you “ping” a station that is “greyed out” 
(offline), D-Rats will apparently get into a “pinging loop” until the station 
that requested the ping, disconnects. The thought is that D-Rats is trying to 
ping it until so many times where it finally times out.                             

The best thing to do to prevent the rapid fire ping is right click on the grayed 
out station and select REMOVE. After removal, when a ping-all-stations is 
done, D-Rats will not try to ping an off air station. N3TSZ says that D-Rats 
always has done this, and apparently, while it is not harmful…it can be rather
annoying.

Quick Messages:

Using the Function Keys (F1 through F8), you can set up macros for items 
that you frequently type. The F7 key may need to be hit twice for it to be sent 
out. 

You can enter things like “Visit my personal homepage at [insert desired URL
here]”, “Checkins for [Net Name] will start at [Net Time] on [Location]”, 
“Checkins for [Net Name] now being taken. You may secure your station at 
your leisure after you’ve been acknowledged”, or whatever you’d like.

Click on ADD to enter the text string desired...and click on REMOVE to 
remove it. This is especially useful for, and during nets.

QST’s:

You can have your station send out a “QST” of various things, at certain 
intervals around the clock, and either just on your current ratflector, or on 
every ratflector that you have set up. The intervals available are at 15 or 30 
minutes past the hour, or a certain number of minutes. Some options that are 
available include the following:

! GPS-A – this will send out your latitude and longitude, along with your 
DPRS designator (covered earlier in this file) to https://aprs.fi 

https://aprs.fi/


! OpenWeather – this will send out either your current weather, or a forecast 
for the weather station used (such as a nearby airport). Setup is covered 
earlier in this file.

! Text – this will send out a simple text string, sort of like a beacon.

! RSS – according to Wikipedia, RSS is a web feed that allows users and 
applications to access updates to websites in a standardized, computer-
readable format. These feeds can, for example, allow a user to keep track of 
many different websites in a single news aggregator. 

Many National Weather Service websites have RSS feeds, and some computer
bulletin board system (BBS) websites, among many others, also have RSS 
feeds available. I have not used the File, Exec, or GPS settings. The main ones
that I use are GPS-A, OpenWeather, and Text.

Messages:

With D-Rats you can create and send the following messages:

! Incident Command System (ICS) 213 messages.

! HICS260 messages.

! A memo message.

! A Radiogram, in National Traffic System (NTS) format.

! Email message. When they connect to D-Rats, the message will be sent. If 
you see them online, you can go to File →Messages →Send/Receive, and click 
on that...outgoing messages will be sent.

As noted earlier, I use Winlink Express for Winlink 2000 (WL2K) messages, 
and Gmail for my email messages. This way, if I have to reinstall D-Rats 
(which I’ve had to do on occasion), I don’t lose anything I have previously 
saved. The files, messages, etc. are saved either within Gmail or Winlink 
Express folders that I chose.

On the next page, I’ll cover the File Transfer Area in D-Rats.



Files:

In your D-Rats Shared folder, this is where you put files you’d like for others 
to download, or for where folks upload files to you. Files that you download 
from another station will go here. 

You can connect to another station currently online, and upload them a file 
from your files area. With the filenames, if you place a number and an 
underscore before them, that will put those files toward the top of the display 
that connecting stations will see (thanks to John, KD7AAT, for this tip). The 
“number prefixes” are from 0 through 9.

In the left column, are the files on your system. On the right column, will be 
the files from the system you’re connecting to. 

On the next page is a screenshot of what this looks like. Stations that are 
currently online are in the window on the right side of the page. Move the 
mouse over the callsign to see the ratflector they were “last heard on”. You 
will need that information to connect to them, to send them the files. 

Stations that are in BLUE are currently online, while stations in GOLD are in
what’s known as “Unattended Mode”. While their station is “up”, they may 
not be at the computer itself at the current time.

As noted earlier in the file, I have 2 D-Rats setups...one is at WX4QZ-1, on the
Windows 11 laptop…and the other is at WX4QZ-15, on the Windows 10 
desktop, where I have to run my D-Star Nets from. 

I’ve decided to keep all the files on WX4QZ-1 – the WX4QZ-15 setup is used 
ONLY when I’m doing checkins for the Arklatex D-Star Net, which is on 
Tuesday nights, on Reflector 48 B. Early checkins begin at 7pm US Central 
Time (30 minutes prior to the net), and the net itself starts at 7:30pm Central 
Time.

Note that if the National Weather Service in Shreveport, Louisiana has 
commandeered Reflector 48 for Skywarn Severe Weather Operations in the 
Arklatex Region, the Arklatex D-Star Net that night is canceled.



Next, choose that particular ratflector, and type in the station callsign you 
want to connect to. Then, click on CONNECT. The files that they already 
have in their D-Rats Shared folder, will be below the window where you chose
the ratflector, and entered their callsign.

To send (upload) a file from your system to theirs, click on the desired file in 
the left column, then click on UPLOAD. To receive (download) a file from 
another system, click on the desired file in the right column, then click on 
DOWNLOAD. 

In either case, the systems will do a file handshake, then the file transfer will 
start. If the file is rather large, the transfer may take some time. When you 
are finished, click on DISCONNECT.

Again, obviously “practice safe hex”, and make sure that anything you 
download, or have uploaded, does not have malware, viruses, ransomware, 
etc. with them. 

I personally use the Iobit Suite of products (https://www.iobit.com) for my 
system. They have the following utilities:

https://www.iobit.com/


! Advanced System Care – scans your system for various issues, including 
junk files, malware, registry data, security issues, defragmentation, and more.

! IObit Malware Fighter – Besides scanning for malware, it has protection for 
ransomware, along with additional virus protection. 

Ransomware is where your system is locked, and your data is encrypted, until
you pay the hackers a large amount of money, usually in bitcoins (which can 
be very expensive). However, there’s no guarantee that the thugs will release 
the key to unlock the data, and they may destroy the data anyway, even if you
send them the money. It’s best to have an offline data backup, so if needed, 
you can completely format the hard drive, and restore the operating system, 
and the files that were encrypted.

! Driver Booster – Checks to be sure your system drivers are up to date.

! Smart Defrag – Files that are used often become fragmented, and it ends up 
slowing the system down, as the system has to look for each “file piece”. The 
defragmentation puts everything back together, as it were, restoring system 
speed.

! Uninstaller – Remove those Windows programs, web browser addons, and 
associated registry entries that you no longer wish to have on your system.

! Software Updater – Automatically updates software on your system (the 
Security Fixes in Advanced System Care check for Windows Updates, if your 
operating system is current). You also have the option to install other new 
programs. Note that with most Windows Updates, a reboot will be required 
after the installations are done.

! Start Menu 8 – If you don’t like the Windows 10 or 11 start menu, but prefer
the legacy start menu from Windows 7 and Windows 8 (as I do), this allows 
you to revert to that. To me, the Windows 10 and 11 start menus are “too busy
and complicated”. You can also change the Start Menu icon in the Windows 
taskbar. 

! Screen Shot – One of the utilities allows you take a picture of what is on 
your screen, resize it, then save it as a graphic (usually a PNG file, although 
you can use another graphics format, if you so desire).



Most of these allow you to register 3 computers for 1 price...renewable and 
payable each year. Personally, I feel it’s money well spent.

UTC Times:

For openers, NOT every ham radio operator uses UTC Time in their shack, 
unless they’re avid contesters, or they prefer to use such. There’s NOTHING 
in Part 97 of the FCC Rules, that require hams to use UTC Time in their 
shacks. 

In the United States and its territories, Daylight Savings Time (DST) is from 
the 2nd Sunday in March to the 1st Sunday in November...and Standard Time 
is in effect the rest of the year. Note that Arizona, Hawaii, and some territories
are on Standard Time year round. A simple link for converting current US 
Times to UTC time is at https://tycho.usno.navy.mil/simpletime.html 

The time is in military time (24 hour) format. Note that a UTC Time 
Conversion Chart for the same areas is at:

https://www.scc-ares-races.org/generalinfo/utcchart.html

The times here are also in military time (24 hour) format.

It's helpful to have both a calendar, and a dual time clock in the shack. There 
are programs that you can use to view different time zones on your computer.
One that I’ve used was a program for Windows called QLOCK, available at:

http://www.qlock.com/download/ 

There is a free version, a single user, and a multi-user version. A comparison 
of the features of each version is at:

http://www.qlock.com/compare.html 

For me, besides being a “frugal cheapskate” (hi hi), the freeware version does 
all that I want/need it to do.

Another option for telling your local time versus UTC (GMT) time, I highly 
recommend the MFJ-108B from MFJ Enterprises. It’s the least expensive of 

http://www.qlock.com/compare.html
http://www.qlock.com/download/
https://www.scc-ares-races.org/generalinfo/utcchart.html
https://tycho.usno.navy.mil/simpletime.html


all the related items on their website (see it for the exact price), noted in the 
link from the MFJ website.

https://www.mfjenterprises.com/Product.php?productid=MFJ-108B 

Another application would be to use Google Calendar, or the calendar at 
groups.io – and make a list yourself. 

You can find a groups.io DMR Nets calendar at:

https://azdmr.groups.io/g/N8NQPRepeater/calendar 

There is a hyperlink in my QRZ bio (http://www.wx4qz.net/elk.htm) that has 
a link to an Excel Spreadsheet with a UTC Utility to convert area net times to 
UTC...which NEVER changes, no matter what time of year that it is. Again, 
UTC is what is based at the Greenwich Meridian, at 0 degrees longitude (the 
equator is at 0 degrees latitude).

Depending on where you are, your times to DST or Standard Time may occur
at different times of the year, from when the US does its time changes. 

In short, check with the various Net Control Stations on net times.

Net Memberships:

For the QCWA, CERT, ARES, AMSAT, Handi-Hams, or other Organization 
or Club Nets, membership in these is NOT required to checkin to them. The 
only requirement to checkin to a net, is that you’re a licensed amateur radio 
operator, with transmitting privileges on D-Star, DMR, WIRES-X, Fusion, D-
Rats, or whatever other mode the net is on.

In the United States and its territories, this is the Technician Class license or 
above...as most of the frequencies for the other modes noted are not available 
to Novice Class hams. For most of the nets that are on HF, a US General Class
license, or higher, is required, to checkin...unless the net is in the Technician 
Class portion of the 10 meter band, where both Novices and Technicians can 
checkin to the net.

http://www.wx4qz.net/elk.htm
https://azdmr.groups.io/g/N8NQPRepeater/calendar
https://www.mfjenterprises.com/Product.php?productid=MFJ-108B


The only exception is for nets on CQ100...where ANY amateur radio operator
who is currently licensed, and paid up with their CQ100 subscription, can use
any of the frequencies available. Paid members on CQ100 get an “add-on” 
called QSO-TV, a quasi-ATV setup. Usage on CQ100 is FREE from 0000 to 
2359 UTC on Sunday. First time users can get a 30 day free trial. Go to 
https://www.qsonet.com for more info on CQ100.

Other Net Links:

D-Star HF Nets: http://www.dstarinfo.com/DSTARHFNet.aspx 

CQ100 Nets: http://www.w2blc.net/cq100nets.htm 

DMR Nets: http://mrickey.com/dmr-nets/ 

FreeStar Nets: https://freestar.network/netcontrol/ 

QuadNet Array Nets: https://www.openquad.net 

HamSphere USA Nets: https://www.hamsphere.com/6_54114_read.html 

Hamsphere Information: http://www.hamsphere.com

Yaesu System Fusion Nets: https://yaesu-system-fusion-nets.net/ 

AllStar Related Nets: https://kc3cduonline.wordpress.com/are-there-any-
good-allstar-nets/ 

And, for those who want them…

Christian Related Nets: http://www.mymorninglight.org/ham/C'n-Nets.htm 

There may be errors on those other pages...and I am ONLY responsible for 
information in the net list spreadsheet files – please advise me of any errors.

I don’t use HamSphere anymore, due to cost, and a lack of time (there are 
other things in life besides amateur radio). Ham Radio is a HOBBY, and it 
should NEVER take priority over things like church, family, health, job, or 

http://www.hamsphere.com/
http://www.mymorninglight.org/ham/C'n-Nets.htm
https://kc3cduonline.wordpress.com/are-there-any-good-allstar-nets/
https://kc3cduonline.wordpress.com/are-there-any-good-allstar-nets/
https://yaesu-system-fusion-nets.net/
https://www.hamsphere.com/6_54114_read.html
https://www.openquad.net/
https://freestar.network/netcontrol/
http://mrickey.com/dmr-nets/
http://www.w2blc.net/cq100nets.htm
http://www.dstarinfo.com/DSTARHFNet.aspx
https://www.qsonet.com/


honey-do’s. Otherwise, as noted earlier...that rig you have your eye on for 
your birthday or a Christmas gift, is “going back to the candy store” (hi hi).

There are yearly fees for CQ100 and HamSphere, and for some RemoteBase 
operations (a few RemoteBase operations hams will let you use their system 
for free, with prior arrangements). Note that some RemoteBase operations 
fees can be rather expensive. You must have permission of the individual or 
club/organization to use that link. And, no matter the mode, some nets listed 
may no longer be active, and all nets are subject to last minute cancellations 
(weather, internet, Net Control issues, holidays, etc.). Please see the PDF file 
“Nets where WX4QZ is Net Control”, at the hyperlink URL on my QRZ bio, 
for further information on those nets.

** IMPORTANT INFORMATION REGARDING NET TIMES!! **

Net times in the nets list spreadsheet files are based on the 4 United States 
Time Zones. You need OpenOffice, LibreOffice, Microsoft Office, or the 
equivalent, to view, use, sort, etc., the spreadsheet file data.

As of March, 2023, for the U.S. Net Times, the difference between United 
States Eastern Time and UTC (or GMT if you prefer), is 5 hours from the 1st 
Sunday in November, to the 2nd Sunday in March; 4 hours difference the rest
of the year. Whether this will change in future years, remains to be seen. 
Some states are going to either “Standard” or “Daylight Savings Time” (DST)
year round. Check with your area to determine the local time versus UTC.

Note that with the emergence of the worldwide pandemic of the CoronaVirus 
(COVID-19), most other events were being postponed or canceled. At least 
with being on the air from ones own QTH (especially if one lives alone), you 
don’t have to worry about masks, gloves, or “social distancing”.

Also, note that Net Controls are donating an hour or more of their time 
before, during, and after the net, for logging, and other related tasks. And, 
some of these Net Control operators run more than one net per week (as I 
do)...so, they have to be on guard for “burnout”. Plus, for Net Controls like 
myself, who have arthritis, or other ailments that make it painful to be seated 
for a long period of time, it’s very uncomfortable sitting for a long time...just 
to keep the net open, where a straggler can show up, and checkin whenever 



they feel like it. In this case, falling when one gets up, resulting in serious 
injury, is a real concern.

While I personally will give plenty of opportunity for folks to checkin, I’m not
going to “wait forever” for someone to show up. When it looks like all of the 
checkins have “dried up”, I will make a final call for rechecks, late checkins, 
or anything else to come before the net. If I get some, I’ll keep it going, but 
otherwise, it’s “the last call”. In short, you can’t be “fashionably late” for a 
net. If you are, the net may have long since secured, and your checkin won’t 
be logged. In that case, Net Control will get you another time. 

        ** The QuadNet Array versus the US Trust Server Reflectors **

The following information is courtesy of VE6DV, KD4IZ, KA2E, KA2BSM, 
KI7SBU, W4WWM, W5SLG, ZL2BEZ, and KC9SIO...my apologies for 
anyone that I may have missed. 



For those who’ve used the US Trust Server Reflectors (noted by REF, the 
reflector number, and the mode, or by the number and mode noted in this file,
such as REF 26A or 26A)...you can do so much more on the QuadNet Array. 
It allows connections to D-Star and other modes, as on the graphic noted on 
the previous page. More info on how to use the QuadNet Array, is at 
https://openquad.net 

NOTE: The Peanut app for Android phones, the VoIP app of Echolink, and 
the DMR Brandmeister Talkgroup 31012 are NOT linked to the QuadNet 
Array. 

Internet latency issues with the Peanut App and Echolink were the reasons 
these were disconnected. The DMR Brandmeister servers were out of the 
control of the QuadNet Array administrators, and many times, data from 
there would not “make the trip”. DMR users should instead use DMR Plus, 
noted later in the document. The IPSC-QuadNet and IPSC-QuadNet2 DMR 
Plus servers ARE under the control of the QuadNet Array, and issues can be 
dealt with more readily. Details on using DMR Plus with the QuadNet Array 
are located later in this document.

The following information is from Jeff, VE6DV, Net Control for the 
Multimode Digital Voice Net, which meets on the QuadNet Array on Saturday
afternoons, US Time:

1. We’ve changed the module on the reflectors within our control from D to A,
for those who are wanting to connect to a reflector to access the QuadNet 
Array. This includes XRF757, XRF307 and XLX587. XLX049 remains on the 
D module, as their reflector has other reflectors linked on their A module.

2. As you may have noticed in item 1 (noted on the previous page), we have 
added a new reflector to the array, XLX587. This will allow people to spread 
out a bit more and not need to congregate onto a single reflector.

3. We now have 2 IPSC2 DMR+ servers available:

    IPSC2-QuadNet - https://dmr.openquad.net/
    IPSC2-QuadNet2 – http://dmr.openquad.net/

https://openquad.net/


Both servers are available for everyone to use, as each are configured 
identically. The main idea is if one server goes down, you can switch to the 
other server to continue to operate. 

As noted earlier, with the REMOVAL of DMR Brandmeister TalkGroup 
31012 into the QuadNet Array, DMR users whould use one of the two servers 
noted above. 

4. We believe that we’ve eliminated the looping issue, when using the Array. It
appears to have been come from outside of our servers on DMR+ talkgroup 
320. When we stopped sharing talkgroup 320 to all of the other IPSC2 
servers, the looping went away.

From Paul, ZL2BEZ, here are some notes for setting up the BlueDV program 
to work with DMR Plus on the QuadNet Array.

A. In the AMBE tab, make sure the DMR Talk Group is set to 320, and G is 
visible next to it.

B. You may need to adjust the DMR gain settings to suit your headset mic, if 
you’re using one.



C. The firmware and DMR Master will show your dongle name and DMR 
Master Server Name. A screenshot of that is noted at the top of the next page. 
While from a previous version, the data should still apply.

D. To prevent confusion, please remove the check marks for “Enable At 
Start” for D-Star and Fusion. You will need a default system to connect to, 
but you do NOT need to have “Enable At Start” checked. This way, you are 
free to choose which mode you wish to operate.

E. On the setup page for the BlueDV program as noted earlier, you’ll enter 
the following (we are using DMR Plus for the QuadNet Array setup) – the 
screenshot for it is first:

1. For your DMR ID, enter your own DMR ID to DMR ID Hotspot and DMR 
ID Simple. For each hotspot, ThumbDV, DV Mega Stick 30, etc., you will need
to assign a specific 2 number ID for it, such as 01 if you just have one device. 
The 01 suffix goes on the DMR ID Hotspot Line after your DMR ID. For the 
DMR ID Simple Line, the 2 number ID should be omitted.

2. Set the DMR Type to DMRPLUS – as noted above, DMR Brandmeister 
Talkgroup 31012 into the QuadNet Array is NO LONGER AVAILABLE, 
although it may be available OUTSIDE of the QuadNet Array.



3. Set the DMR+ Master ID to IPSC2-QUADNET (this is what I’m using).

4. If you wish to enable that at the start, click the appropriate box. By NOT 
checking ANY of those “enable at start” boxes, you are free to choose which 
mode you wish to operate (graphic noted on next page).

Also, from Will, W4WWM, one of the administrators of the QuadNet Array:

You can also look on QuadNet Master Bridge Server dashboard to see your 
information. The QBridge is monitoring all our servers. 

https://qbridge.openquad.net/index.php 

**

For those who have been on DMR, and are confused on converting to DMR 
Plus, here’s info from Jeff, VE6DV:

When it comes to DMR, people usually think of Brandmeister. But there is 
another network rapidly gaining popularity in North America worthy of your
attention – DMR Plus. DMR Plus gives you many of the same features as 
Brandmeister such as talkgroups, SMS messaging and private call, but also 
adds reflectors and more. The main difference is DMR Plus presents these 
features in a well thought out manner which allows for outstanding flexibility 
when it comes to the way we communicate.

Doing a Google search for DMR Plus comes up with the following from the 
DMR-MARC website:

DMR Plus is the original network that developed tools to interconnect ETSI 
Tier 2 DMR repeaters. It has been popular in Europe for years but now, with 
the cooperation of DMR-MARC, it has finally arrived in North America and 
the South Pacific. The DMR Plus architecture is similar to D-Star. Users have 
talkgroups to converse, to disconnect, and to monitor channel status. Users 
choose from a large pool of reflectors and move back to the converse 
talkgroup for all QSOs.

The DMR-MARC and DMR Plus partnership is ideal. The DMR-MARC 
network is robust and reliable. The DMR Plus network is more aligned with 

https://qbridge.openquad.net/index.php


experimentation and interoperability of technologies. Think of DMR Plus as 
the best possible implementation of the former DMR-MARC Sandbox.

DMR Plus also supports a configuration that features the traditional DMR-
MARC talkgroups like Worldwide English, North America, Latin America, 
etc. on TS1 and the DMR-Plus reflectors on TS2. The USA Regional 
talkgroups and the Canadian Provincial talkgroups are now connected to the 
TS2 reflectors.

Like Brandmeister, DMR Plus uses talkgroups, but they also use reflectors. A 
reflector is kind of like a hub that allows you to communicate with everyone 
else that is also connected to that same reflector. But on DMR Plus, the 
reflector itself can be bridged to either another talkgroup, another reflector or
even another network or digital voice mode.

One perfect example of this is the QuadNet Array. The Array brings the most 
popular digital voice modes under the same roof. You can find the QuadNet 
Array on reflector 4541 (corrected talk group) or DMR Plus talkgroup 320. 
By connecting to either of these your transmission can be heard by users on 
DMR Plus, but also Yaesu System Fusion and Wires-x, D- STAR reflector 
XRF757A, Smart Groups DSTAR1 and more.

Again, for a complete overview of the QuadNet Array, visit the QuadNet 
website at https://openquad.net. 

If you’d like to explore the various DMR reflectors that are available, you can
get an updated list at https://www.pistar.uk/dmr_dmr+_reflectors.php 

One thing that stands out in my experience is that DMR Plus appears to have 
better audio quality than Brandmeister. I find much fewer dropouts and 
lower packet loss on the DMR Plus network. 

So, what do you need in order to give DMR Plus a try? If you are running a 
Pi-STAR based hotspot you are good to go. The OpenSPOT will also allow 
you to use DMR Plus. However since I have not had the opportunity to use 
one I am not able to give you specific setup instructions. Refer to the
OpenSPOT website and Facebook group for more information.

In Pi-STAR version 4, do the following:

https://www.pistar.uk/dmr_dmr+_reflectors.php
https://openquad.net/


1. Login to your dashboard

2. Click on configuration

3. Scroll down to DMR Configuration

4. Under the DMR Master setting select DMR+_IPSC2-Quadnet or 
DMR+_IPSC2-Quadnet2 and click on apply settings.

While you can use any IPSC2 server you like, I recommend DMR+_IPSC2-
Quadnet or DMR+_IPSC2-Quadnet2 because it is very well maintained and 
extremely stable. We make sure it is up to date with the latest available 
talkgroups, the newest software version unless there is a bug found that was
working in a previous version. I also feel the Quadnet technical support team 
is second to none. We’re very responsive when it comes to support requests as 
well as adding requested DMR Plus talkgroups to the server. If there is a 
talkgroup you are having difficulty accessing on IPSC2-Quadnet visit our
website at https://openquad.net -- then click on the Contact Us tab and let us 
know how we can help.

Once your hotspot returns to the configuration page, enter the following in 
the options= box

If you have a simplex hotspot:
StartRef=;RelinkTime=240;TS1_1=320;TS1_2=321;TS1_3=302;TS1_4=;TS1_
5=3;TS1_6=13;TS1_7=33;TS1_8=505;

If you have a duplex hotspot:

StartRef=;RelinkTime=240;TS1_1=320;TS1_2=321;TS1_3=302;TS1_4=;TS1_
5=3;TS1_6=13;TS1_7=33;TS1_8=505;TS2_1=3;TS2_2=13;TS2_3=33;TS2_4=
321;TS2_5=505;TS2_6=530;TS2_7=;TS2_8=;

Once entered, click on apply changes.

What this line means is you are having your hotspot not automatically link to 
a reflector upon startup. 

https://openquad.net/


If you want to setup a default reflector, enter the reflector number after the 
StartRef= command.

RelinkTime means if you do link to a reflector it will automatically disconnect
after 240 minutes if you don’t key your mic to reset the timer. If you have a 
default reflector set and change to a different reflector your hotspot will 
automatically return to the default reflector after the time expires. UserLink
tells your hotspot to allow you to link to talkgroups and reflectors via RF. The
TS1 lines setup static talkgroups. 

In this example I have setup the following talkgroups:
320 – The Quadnet Array
321 – Quadnet Tech Talk
302 – Canada Wide
3 – North America
13 – WW English
33 – NA English
505 – Australia

The duplex hotspot adds the following talkgroups on TimeSlot 2:3 – North 
America

13 – WW English
33 – NA English
321 – Quadnet Tech Talk
505 - Australia
530 – New Zealand (listen only unless you have a ZL call sign)

Now in your radio code plug, you will want to add the above talkgroups so 
you will be able to use them easily. Also you will want to add any reflectors 
that you would like to use (see the link earlier in this article to find the list of 
available DMR Plus reflectors) in your radio code plug as well. In Pi-Star, to
send your transmission to a reflector you will also need to add talkgroup 9.

I hope you decide to give DMR Plus a try. If you have any questions you can 
usually find me on the QuadNet Array talkgroup 320. If you prefer you can 
also contact me via email. I can be reached at jeff.ve6dv@gmail.com 

**

mailto:jeff.ve6dv@gmail.com


When I’m on the air (which now is just for nets, as I have other things in life 
besides ham radio that demand my attention), I use the ThumbDV from 
Northwest Digital Radio or the DV MegaStick 30 from Gigaparts (around 
$119 plus shipping, which is at least $80 cheaper than the DV Dongle), and 
the BlueDV program from PA7LIM. Prices for these, can change, though.

In my opinion, both of these items are far more versatile than the DV Dongle, 
and the DVTool program from AA4RC. Prices for these may change; check 
the Northwest Digital Radio and Gigaparts websites for full details. Note that 
both of these are very popular items, and can be “out of stock/back ordered” 
quite a bit. 

I also use a headset mic, and a computer...I have no RF gear at the QTH. I’m 
at what was my late parents home. I lost my Dad and my wife in early 2007 
(nearly 3 months apart), and lost my Mom in the summer of 2019. My health 
will not allow me to get up on the roof, and we get intense lightning during 
thunderstorms.

Note that the DVTool program, with a DV Dongle, ONLY allows access to the 
US Trust Server Reflectors (REF) on D-Star, because of proprietary issues.
However, using the ThumbDV and the BlueDV program, you can access D-
Star (REF, XRF, XLX, or DCS Reflectors), DMR, and System Fusion; either 
with your rig and computer...or via your computer without a rig. As noted 
earlier, you need to be using a high speed internet connection, since dial-up 
internet is NOT recommended, as it’s too slow.

If you are using an MMDVM (Pi-Star) or openSPOT (I or II) hotspot OR: If 
you're using an MMDVM multimode repeater:

1. Create a “LINK” in your D-Star Radio Memory Group to XRF 757A
(UrCall = XRF757AL)

2. Use Urcall = CQCQCQ to talk while you are on the net.

3. DON'T FORGET to UNLINK with a UrCall = _______U (7 spaces then a 
U) after the net.

Changes In QuadNet D-Star Routing:



In order to better serve the QuadNet D-Star Routing community, we are 
moving our D-Star Routing IRC Servers. The new URLs for the IPv4 and 
IPv6 IRC servers are ircv4.openquad.net and ircv6.openquad.net, 
respectively. 

There will still be a diminished server operating on rr.openquad.net to fulfill 
the login needs of clients still using that address, but it will no longer provide 
IRC update messages to its clients. In other words, clients still using 
rr.openquad.net will no longer be able to find IP addresses for their desired 
routing targets. If you use routing on QuadNet, be sure to update the IRC 
routing server name in your hotspot or reflector software. If you operate a 
Smart Group Server or are STARnet Server, you’ll also need to update those 
clients. 

If you do not do D-Star Routing, no action on your part is required. This 
move will not affect REF, DCS, XRF or XLX linking to any of our reflectors, 
XLX307, XLX587, XRF735 or XRF757.

DMR:

We need the DMR users to move over to the IPSC2-QuadNet Server, which is 
DMR+ Server TG 320, and Slot 1 for QuadNet Array. The information is at 
https://openquad.net on how to configure. The QuadNet team have complete 
control of that server. 

As noted, Brandmeister DMR TalkGroup 31012 is NO LONGER LINKED 
into the QuadNet Array.

Once others take the time to learn how to connect to QuadNet's DMR + 
Server (IPSC2) they will most likely see a bigger and better improvement for 
DMR use.

With the next major release of pi-star implementation of DG-ID support into 
the software it takes advantage of DG-ID support with repeaters and users 
via there Yaesu radios as well as there hotspots and thanks to all the admins 
and the new YCS310 server you can connect directly with your hotspot to the 
array. DG-ID support is currently available via QnetGateway software and a 
custom pi-star build from EA7EE.

https://openquad.net/


Also, for those who want a challenge, a user can build the module software 
called QnetGateway Multi Protocol Build (MPB), which support D-Star, 
DMR and YSFGateway which is tailored for the QuadNet network by our 
very own Tom, N7TAE. You can find the link for this on our website or shoot 
admins an email and join the QnetGateway io groups for help when needed.

DMR+ Reflector 4541

Yaesu System Fusion: US QuadNet Array (https://ysf.openquad.net/) number 
35947

**

From Will, W4WWM, one of the administrators of the QuadNet Array:

Fusion Rigs can connect to the QuadNet C4FM's YCS310 Server using 
MMDVM system like Pi-Star Hotspots or DR2X (Fusion System II repeaters)
and Shark RF Openspot systems. These connections will connect on 
QuadNets C4FM YCS310 Server to reflectors --> FCS31080 and/or 
YSF31080. The room 80 mean using DG-ID 80 such as YSF31080 or 
FCS31080 for that room on the mention C4FM Server.

Basically, if your setup supports MMDVM, you can still get into the QuadNet 
Array. They are working on adding another new digital mode, M17, to the 
QuadNet Array. The website, https://openquad.net, will be updated with this 
information as soon as possible.

For D-Star OpenSpot users who haven’t used DCS/XLX reflectors before; 
these instructions use XLX757A as an example, but enter your desired X-
Reflector, and module, from the list noted above.

From the web interface/connectors tab, add a D-Star DCS/XLX connector.
On the D-STAR/DCS/XLX connector screen, set the modem receive and 
transmit frequencies to what you've been using. (Be sure to double check your
frequencies, as they will NOT carry over from other connectors you've set.)

Server: Select XLX757 (or the desired X-Reflector from the list noted above).
Module: Select "A." (or the desired module from the list noted above).

https://openquad.net/
https://ysf.openquad.net/


Callsign: Enter your callsign.

CLICK SAVE - don't forget this!

After you've set the connector, you can use your radio to select reflectors with 
the appropriate URCALL command (i.e. "REF026AL" or "XLX757AL") the
OpenSpot remains on the last connected reflector. If anybody needs help 
using an OpenSpot with a TH-D74a, you can contact Mike Sturm, KA2E, at 
ka2e@arrl.net

Again, note that DMR Brandmeister TalkGroup 31012, the Peanut App, and 
Echolink are NO LONGER LINKED to the QuadNet Array. 

For Peanut Users, you can get a list of the rooms that are available via the 
Peanut app at:

http://peanut.pa7lim/rooms.html 

While some hams won’t be able to be on nets on the QuadNet Array (their 
rigs or repeaters don't have the capabilities for the modes, X-Reflectors, etc.); 
I’d rather have a NET GAIN, than a NET LOSS, in checkins. Obviously, 
there’s no need for nets, if there are no checkins.

While there are “too many nets, and too little time”, there are far too many 
nets and modes to cover in the hobby, let alone in this lengthy document.

How To Contact me (Daryl Stout, WX4QZ) via amateur radio and otherwise:

1) Go to https://www.wx4qz.net/fbk.htm -- and follow the instructions.

2) Via Facebook with a message to me in one of the groups that I moderate. 
Prior to my Mom's death in August, 2019, numerous hacks on my account, 
and via "friends" wanting me to "like, share, and view" various links, burned
me out...where I UNFRIENDED everyone. While I can take “friend 
requests”, I normally don’t “follow” folks. I’m still reachable via Messenger, 
but have very few Facebook friends, per se, anymore (and I’m very picky on 
any “friend requests”. The "profile picture" is yours truly in his Train 
Conductors outfit...with the cover photo a family portrait from Dec. 25, 1962.

https://www.theweatherwonder.com/fbk.htm
http://peanut.pa7lim/rooms.html
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While my brother is still alive, both our parents are dead and gone. However, 
while we were both raised in the same household, and are both male, we are 
as different as night and day, in regards to hobbies, interests, etc...and like our
Dad (who died in February, 2007), he hates computers. Unfortunately, due to 
financial and other issues, I rarely have contact with him.

3) Via Twitter -- look for @wx1der -- I am VERY SELECTIVE on who I 
"follow"...and use it VERY SPARINGLY.
  
4) Via Postal Mail to P.O. Box 55655, Little Rock, AR 72215 -- I check the 
Post Office Box twice a month; weather, health, and schedule permitting. 
With no longer driving, or having a car, I take Lyft to the Post Office Box 
twice a month, and on other errands, as the need arises. Plus, taking Lyft, 
depending on the time of day, and the day of the week, can get rather 
expensive. Being on a fixed income, what I get in disability each month, 
doesn’t go very far.

5) Via Skype or Zoom -- look for Daryl Stout – note that both of these are 
used VERY SPARINGLY.

6) For licensed Amateur Radio Operators, you can reach me via several ways:
a) Selected Nets during the week, as noted in the PDF file “Selected Nets 
where WX4QZ is Net Control”.

b) Send a message to WX4QZ-1 on D-Rats. I mainly monitor WX4QZ-1 (on 
the Windows 11 laptop computer), and use the WX4QZ-15 setup (on the 
Windows 10 desktop computer) when I do the Arklatex D-Star Net on 
Tuesday evening. I can do the CQ100 Net, Echolink, Packet Via Telnet, or 
RMS Express (Winlink) on the Windows 11 laptop computer. WX4QZ-15 is 
offline except for during the Arklatex D-Star Net, early checkins, and for the 
net. Weather and internet permitting, WX4QZ-1 is up all the time.

c) Email to wx4qz@arrl.net or to wx4qz@winlink.org – the Winlink account 
is checked once a week...the other account is checked daily. Note that the 
wx4qz@arrl.net goes to my Gmail account, wx1der@gmail.com – that is my 
former callsign, but since I have so much tied up with that email...and since 
Gmail requires at least 6 characters in an email prefix, I couldn’t see setting 
up an entirely new email account.

mailto:wx1der@gmail.com
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d) Packet Radio users can send a message via the Outpost Packet client, or 
from the packet BBS itself to WX4QZ@NS2B.#WNY.NY.USA.NOAM – note 
that if this is sent via anything else besides a packet radio message program, it
will bounce back as being undeliverable.

e) HamShack Hotline users can contact me at 4848. This is a PRIVATE VoIP 
party line service, exclusively for licensed ham radio operators. For details, go
to https://www.hamshackhotline.com – I normally have it set to be in “Do Not
Disturb” mode, especially when running nets, or when I’m asleep. Just leave a
voice mail, your name, callsign, and Hamshack Hotline Number, and I’ll call 
you back as soon as possible.

f) On selected Echolink Nets, or for sked requests. 

g) "Eyeball QSO's" are done at central Arkansas area ham radio license 
exam sessions. Unfortunately, since I don’t drive anymore due to vision issues,
and I do nets on Saturday mornings...and since there is no longer a hamfest 
held in the Little Rock area anymore (and I doubt that there ever will be 
again), I don’t attend hamfests anymore.

Further information is in my bio, located in the PDF file at the hyperlink on 
my QRZ page, and at http://www.wx4qz.net/elk.htm 

You can see a picture of yours truly on my bio on QRZ, along with a picture 
of my eQSL card (I do NOT do paper QSL’s), and a graphic for the Trains 
And Railroads Net that I do on the QuadNet Array on Friday...weather, 
health, and internet, permitting.

Lastly, as noted in the file “Operating Internet Radio” (located at the URL 
noted above), I don’t have any RF gear at the QTH. I’m also a heart patient, 
as of summer, 2021; so, I don’t want to risk anything that could kill me. But, 
even with only operating “internet radio”, my ham radio license isn’t just “a 
sheet of paper”.

If you wish to contact me, my email is good on QRZ.

73,

Daryl Stout, WX4QZ, Little Rock, Arkansas

http://www.wx4qz.net/elk.htm
https://www.hamshackhotline.com/


 

 
 


